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ESSENTIAL READING, SAFETY NOTES 
 
HIGH VOLTAGES 

High voltages are used in this spectrometer. Please exercise care during 
operation and DO NOT operate units with their covers removed. Remember, 
high voltages can be LETHAL. The symbol to the left is attached to some 
units to indicate the presence of high voltage. 

 
DISCONNECTING LEADS 
Do not disconnect any leads from any of the electronic units without first ensuring that 
the units are turned off. 
 
UV LIGHT SOURCE 
Chirascan is equipped with a light source (150W xenon arc lamp) that produces intense 
UV radiation. Never look directly at the lamp without wearing suitable eye protection. 
 
OZONE HAZARD 
Ozone is a very reactive gas that is produced when UV light interacts with oxygen. It is 
essential that the instrument be purged with clean nitrogen prior to igniting the xenon 
arc lamp to prevent the formation of ozone. Failure to purge the instrument will result in 
the formation of ozone, which is damaging to health and can cause deterioration of the 
optical components in the instrument. 
 
ENVIRONMENTAL REQUIREMENTS 
Operating: -  Humidity, 20% to 80% non condensing 

+/- 2oC of a fixed temp in the range 18oC to 26oC. 
Power requirement: <500W total 

 
Storage: -  Temperature, -20°C to +50°C: 

Humidity, 5% to 80% non-condensing 
 
 

Servicing should only be undertaken by qualified personnel. If you are in 
any doubt at all please contact Technical Support at APL. 

 
Email: techsup@photophysics.com               Fax +44(0) 1372 386477 

mailto:techsup@photophysics.com
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HP Compaq PC Configuration 
 
The HP Compaq PC (model dc5100) has been pre-configured for use with your 
Chirascan instrument, but there are some issues that you need to be aware of.  These are 
detailed below. 
 
Administrator Login 
 
The Administrator account currently has no password.  We would advise all customers 
to set the Administrator password of their Chirascan PC. 
 
APLService Account 
 
A user account called “APLService” has been created and given Administrative 
privileges.  This account is used by APL service engineers during servicing of your 
Chirascan instrument.  Chirascan users should not remove this user, nor change the 
password. 
 
Chirascan User Login and the Chirascan Users group 
 
A user account called “Chirascan User” has been created. Chirascan users may wish to 
log-in as “Chirascan User”, or the system administrator may create individual user 
accounts for Chirascan users.  There is a “Chirascan Users” group.  Users who which to 
use the Chirascan software should be made members of the “Chirascan Users” group.  If 
the Chirascan PC is connected to a network then this may affect the way in which users 
log-on to the Chirascan PC.  The system administrator should ensure that “network” or 
“domain” users which want to use the Chirascan software are members of the 
“Chirascan Users” group. 
 
Virus Protection 
 
HP Compaq PC's are currently supplied with Norton Anti-virus software which comes 
with a limited subscription to the Symantec update service.  APL recommends that the 
Chirascan PC have up-to-date anti-virus software installed at all times.  Most customers 
will have a preferred anti-virus sofwtare package, and APL generally recommends that 
the anti-virus software which is supported by the customers' ICT department be 
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installed on the Chirascan PC.  However, please see the section on installing 3rd Party 
software below. 
 
Networking 
 
The Chirascan PC comes as standard with networking capabilities.  However, before the 
Chirascan PC is connected to a network, the Chirascan User should ensure that 
appropriate Anti-virus (and optionally anti-spyware) software is installed and 
maintained.  APL can not be held responsible for failure of the Chirascan PC due to 
viruses or other malware. 
 
Installation of 3rd Party Software 
 
APL is not aware of any conflicts with 3rd Party Software.  However, APL will not be 
held resonsible for failure of the Chirascan software because of any such conflict. 
 
Upgrading Software and/or Hardware 
 
The Chirascan software has been developed for use with Microsoft® Windows XPTM 
and has been extensively tested on the PC's supplied by APL.  APL can not be held 
responsible for failure of the Chirascan software if the Chirascan User or system 
administrator upgrades the PC, or the PC's Operating System (OS). 
 
Technical Support and Licensing 
 
APL will provide technical support, under the terms of the Service Level Agreement, 
for the Chirascan software, subject to the Chirascan Software License, and for the 
supplied PC.  However, APL cannot be held responsible for failure of the software or 
hardware through of misuse or neglect by the customer. 
 
If you have any queries relating to the Chirascan software or the HP Compaq PC, 
tplease contact APL Technical Support at techsup@photophysics.com. 
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Glossary 
 
AC   Alternating current 
APL   Applied Photophysics Ltd 
AU   Absorbance units 
CD   Circular dichroism 
CPL   Circularly polarized light 
CSV   CSViewer or Chirascan viewer 
DC   Direct current 
FWHH   Full width at half height 
FWHM   Full width at half maximum (height) 
HT   High tension – the same as high voltage 
HV   High voltage 
LED   Light-emitting diode 
Lmin-1   Litres per minute 

M   Molar 
PMT   Photo-multiplier tube 
SBW   Spectral bandwidth 
SCP   Spectrometer control panel 
SS   Step size 
UV   Ultra-violet 
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1.0 Introduction 
 
The Chirascan CD spectrometer is a totally new product arising from extensive 
market research into the requirements and expectations of both CD users and 
potential users. The conclusions of the research were that, alongside reduced cost, 
there exists a general need for higher (UV) light throughput, for greater 
productivity and improved ease of use accompanied by greater operational 
confidence. These issues have all been addressed during the development of 
Chirascan. 
 
The purpose of this document is to introduce the technical elements of Chirascan 
which underpin its superior performance, and to describe the overall design of the 
instrument as a whole. 
 
1.0.1 Key technical features 
 

1. Dual polarising prism optics with digital drive and calibration 
2. High throughput F/7 optical coupling 
3. Rapid and economical nitrogen purge design 
4. High performance digital signal processing of raw data 
5. Expandable modular electronics 
6. High speed real-time control 
7. Client server windows software supports remote monitoring of 

experiments in progress 
 
The schematic diagram of Chirascan on page 4.9 illustrates the three key 
subsystems of the instrument – the optical train, the control and acquisition 
electronics, and the Chirascan Windows� software. 
 
1.1 Optical train 
 
The Chirascan light source is a 150W xenon arc with both a rear reflector and 
optimised ellipsoidal focussing mirror for maximum efficiency and light capture. 
The light housing accommodates a pre-aligned lamp assembly for easy lamp 
replacement. The housing must be purged with nitrogen during operation both to 
allow far-UV light transmission but also to prevent the formation of ozone which is 
harmful to health and can damage the optical surfaces. 
 
The Chirascan monochromator features a dual polarising prism design. This yields 
pure linearly polarised monochromatic light and allows high spectral bandwidths in  
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the far-UV. The dual drive system uses two independent stepper driven cams with 
digital calibration correction. Three coupled high precision slits are driven by a 
third stepper motor and a fourth is used to control a variable aperture/shutter. 
 
 The entire monochromator assembly is hermetically sealed to allow operation of 
the optional vacuum assisted nitrogen purge. This enables the interior atmosphere 
to be much more rapidly and effectively replaced with nitrogen (necessary for far-
UV transmission) than when using passive purging methods, and also allows the 
nitrogen atmosphere to be retained for long periods after use. 
  
F/7 optical coupling is maintained throughout the optical path. This has been 
chosen to maximize light throughput without compromising focussing 
performance.  
 
The linearly polarised monochromatic beam that emerges from the exit slit of the 
monochromator is then re-focussed down through the photo-elastic modulator 
(PEM). This device, which acts as a dynamic quarter wave plate (1), modulates the 
beam into alternately left and right circularly polarised states.  
 
The modulated beam then passes into the sample housing. It passes through the 
sample block/cell holder and then on to the photomultiplier CD detector. The 
standard detector port is in line with the beam but a second port is available at the 
rear of the housing. This may be used to accommodate a detector for simultaneous 
fluorescence detection or fluorescence detected CD (FDCD). 
 
Removable sample blocks are provided as standard to accommodate a variety of 
square and circular sample cells. (A range of cell holders and temperature control 
options are also available). Up to four temperature sensors can be monitored and 
magnetic stirrer support can be added as an option.   
 
Two bulkhead access plates are fitted to allow other accessories access to the light 
tight housing. These include Peltier controllers, an optional 4-cell autochanger and 
the titration accessory as well as any of the user’s own devices. 
 
A ‘lid open’ detector is fitted as standard which will pause an experiment in 
progress and reduce the photomultiplier high voltage to prevent damage if the lid is 
raised. 
 
The sample housing has been designed to accommodate quite large specialist cell 
holders and accessories eg cryostats and electromagnets for magnetic CD (MCD) 
experiments. However in exceptional circumstances the entire housing can be 
straightforwardly removed and an alternative sample handling system configured. 
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1.2 Control and acquisition electronics 
 
When the modulated light beam strikes the CD detector it is converted into a 
photocurrent proportional to the incident light flux. Since the beam polarisation is 
circularly modulated at 50kHz, if there is a differential transmission of the two 
states (such as would be caused by CD in the sample), this results in a 50kHz AC 
component superimposed on a background steady state DC component.    
 
The CD is calculated from the ratio of the AC and DC components since CD (in 
terms of 'A) is given by (2,3): 
 

'A = (AL - AR) v (IR - IL)  / (IR + IL) v VAC/VDC
 
Note CD is also expressed commonly in millidegrees, the unit of molecular 
ellipticity (T). The two units can be converted according to the formula: 
 

T (millidegrees) =  32,982 x 'A 
 
The AC and DC signal components are first separated using tuned amplification in 
the detector and passed to the CD acquisition and PEM control module. This uses 
the PEM drive frequency to synchronise a phase sensitive detector (demodulator) 
that generates a voltage signal proportional to the rectified AC component.  This 
rectified AC component and the background DC signal are then digitised using 
independent high-speed 16bit A/D converters. Automatic gain control is applied to 
the incoming signals so as to match them to the optimum range of the digitisation 
stage and so maximise resolution. The digital data is then exported via the back-
plane data bus to the Comms (communications) module for onward transmission to 
the PC. Once in the PC the CD is calculated from the digitised AC and DC 
information according to the formula above and incorporating appropriate gain 
factors (the processing at PC level is discussed in the next section). 
 
The system electronics communicate via a proprietary digital back-plane that can 
support several acquisition and control modules, all operating independently and, if 
required, simultaneously with no loss of data throughput (bandwidth). Digital 
signal processors on all modules are responsible for managing data and decoding 
and executing commands from the PC. 
 
Two twin stepper control modules are used to drive the monochromator cams, slits 
and attenuator. Additional modules can be fitted to allow simultaneous 
fluorescence acquisition or control of sample handling accessories such as stirrers. 
Any additional signal acquisition channels will operate in parallel with existing  
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ones so that sampling frequency is not compromised in multi-channel 
configurations. The Comms module, which is the interface of the electronics to the 
fibre-optic link to the computer, also provides several extra inputs for analogue 
temperature probes and general-purpose digital I/O. Vacant back-plane slots are 
available for future expansion.  
 
All incoming signals (CD AC, CD DC, fluorescence etc) are digitised at a 
minimum sampling period of 10 Pseconds (100kHz). Signals are 1kHz bandwidth 
limited to prevent noise aliasing but are not otherwise filtered in the analogue 
domain. This is to prevent the risk of irreversible distortion of spectral features 
which can arise by the incorrect selection of such smoothing filters when the raw 
input signal is changing too quickly. 
 
The modular design of the electronics means only required features need be 
installed and any faults that develop are localised and can be easily repaired by 
substitution of the appropriate module. All modules have a built in self-test 
capability which communicates any operational problem to the user, and flash 
memory is used to allow all onboard DSP firmware to be upgraded via the 
computer. 
 
1.3 Chirascan Windows� software 
 
Communications between the computer and instrument is carried out over a high-
speed fibre-optic link and a purpose designed PCI interface card and driver handles 
the bi-directional communications and data capture. 
 
1.3.1 Signal processing 
 
Data smoothing during spectral acquistion is provided by user variable digital 
signal averaging. This is applied to the incoming digitised signals at each 
wavelength of measurement. Each resulting averaged data point (which may be the 
result of many thousand individual samples) is guaranteed to accurately represent 
the raw input signal value, since all samples are collected at a fixed wavelength. A 
dedicated high-speed averaging algorithm in the driver software carries out the 
necessary accumulations and computes the averaged result for all monitored 
signals. The operator is able to select the overall sample size. This is most usefully 
presented as the time spent at each spectral wavelength (time per point). This time 
will have a direct bearing on the overall scan time and the signal to noise of the 
result but will never cause a systematic distortion of the kind that can be caused by 
the use of analogue filtering. 
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1.3.2 Application software architecture 
     
The schematic shows the layered architecture of the Chirascan application 
software. The object-oriented design has several benefits particularly from the 
points of view of maintenance, reliability and future expansion. It also allows the 
same overall architecture to be tailored to different APL products providing a 
consistent look and feel across the range.  
 
A feature central to the whole instrument control and acquisition process is the 
datastore. This ‘object’ provides a blueprint for experimental data collection and 
also becomes the data storage object after acquisition. In its simplest form it may 
simply be constructed for a CD spectrum, containing the wavelength range required 
and a time per point parameter etc, but in CD titrations it will contain a dimension 
describing the concentration range to target or for a temperature ramp the 
temperature set points for each measurement. It will also indicate whether 
simultaneous fluorescence or absorption is to be measured. 
 
The device sequencer (level 3) is responsible for taking a datastore blueprint and 
executing the experimental cycle that it describes. This is achieved by sending 
commands to the individual virtual devices which represent the instrument (in the 
level 2 software). These are then translated and passed to the physical instrument 
modules themselves via the driver (level 1) and PCI fibre-optic interface. In our 
simple example the monochromator will move to each point in the wavelength 
dimension and the CD will be measured and stored. The datastore is designed to be 
multidimensional and expandable so that if new measurement variables arise it can 
expand to accommodate them. If new devices are added, eg a fluorescence 
emission monochromator for example, this can be integrated quite easily. 
 
At the top level (level 5) the Chirascan Control Panel provides the GUI for setting 
up and executing an experiment. It is this part of the software with which the 
Chirascan operator interacts. During the set up process a new datastore object is 
created which describes the experiment, which then drives the acquisition and is 
used to accommodate the captured data. 
 
The resulting datastore object is self-contained and forms the basis for the data 
storage on disc. Since the datastore drives the acquisition a datastore filed on disc 
can itself be trivially used to initiate a new and identical acquisition, by dragging it 
onto the Chirascan control panel. All the settings derived from the datastore are 
automatically reflected in the control panel configuration.  
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Data visualisation and management is carried out with the Chirascan Launchpad 
and Viewer (referred to in abbreviated form as CSViewer). Client-server 
architecture means this can operate either on the host computer alongside the 
control panel or on a remote networked computer. This allows experiments in 
progress to be monitored remotely from the instrument, at another location. The 
data is transferred to the launchpad and viewer automatically during acquisition so 
that the experimental measurement appears in real-time. On completion the new 
data can be saved on the PC running the linked viewer, though a backup is always 
stored on the host PC as well. 
 
Once collected the launchpad and viewer can be operated independently of the 
control panel software for navigating amongst data files and performing a range of 
visualisation and data processing options (see software guides). 
 
Finally a range of detailed device windows (level 4) can be accessed on the host PC 
for diagnostic purposes. These are not usually required during normal operation 
and in some cases are password protected to prevent unauthorised interference (as 
calibration data and motor drive parameters can be modified). They are provided to 
allow complete instrument control on site by APL personnel and to allow tests to 
be run by customers under APL supervision. 
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Appendix A: Calculation and importance of 
absorbance measurement with CD 
 
A.1 Introduction 
 
The simultaneous measurement of absorbance during a CD measurement is a useful 
and important facility on Chirascan. The absorbance spectrum provides an 
indication of the transmission of the sample and any solvents present over the 
wavelength range under investigation. This is helpful in judging whether a CD 
measurement is valid, since a lack of light throughput will directly result in an 
erroneous CD due to the attenuation of AC and DC signals to meaningless levels.  
This will usually manifest itself as a marked rise in the noise on the CD spectrum 
but this alone may not, at first glance, indicate the degree of deterioration in the 
validity of the measurement. This is particularly problematic in the UV region of 
the spectrum where many buffers rapidly become opaque but CD information is of 
particular interest (eg during protein scans for secondary structure analysis). The 
absorbance of many common buffers and salts rises very sharply below 200nm and 
this ‘wall’ which is clearly evident in the absorbance spectrum, indicates, to a first 
approximation, the wavelength limit of detection.  
 
The absorbance spectrum of the sample is obviously a useful measurement in its 
own right and is a useful supplement to the CD spectrum. As a rule of thumb, 
optimum CD measurements are commonly obtained where the sample absorbance 
in the cell is about 0.8-1.0 a.u. (2). Much lower and the CD signal will be weak and 
much higher will seriously limit the light reaching the detector. The absorption 
spectrum also provides a measurement of the sample concentration and indeed can 
be used to calculate sample concentration given the observation cell pathlength. 
This will enable accurate molar ellipticity, and molar extinction values to be 
calculated. 
 
An important ratio known as the g-factor, or disymmetry factor, which is the ratio 
of the CD to the absorbance, can also be obtained: 

MA
Ag

H
H'

 
'

    

 
'A is the measured CD, A the absorbance measured under the same conditions, 'H 
is the molar CD and HM the molar extinction coefficient, ie 
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l  is the cell pathlength in cm and  the sample concentration in moles dmc -3. 
The g-factor is a particularly useful quantity when estimating or assessing 
enantiomeric excess (1). 
 
A.2 Absorbance measurement on Chirascan 
 
The simultaneous measurement of absorbance and CD is complicated by the 
mechanism by which CD signals are optimized on Chirascan. Absorbance is 
normally calculated according to: 
 

   
SAMPLE

REF

T
TA log     (i) 

 
REFT  is the light transmission with no sample, only solvent, in the observation cell 

(this is often referred to as 100% transmission or ) .  is the transmission 
with sample in place. For an absorption spectrum, first the solvent transmission is 
scanned (the baseline) followed by the sample to yield corresponding reference and 
sample transmissions at each wavelength. The absorbance spectrum is then simply 
calculated as the log-ratio for each data pair. 

100T SAMPLET

 
It is essential for this calculation to be valid that the two separate measurements are 
taken under identical conditions of detector gain (constant photomultiplier high 
voltage). 
 
However this constraint does not apply to CD baselines and spectra because CD is 
a self-referencing measurement (the AC/DC ratio is available from a single scan). 
The means the detector gain can be automatically adjusted on-the-fly to optimize 
the signal levels and allow the most accurate and low-noise CD measurements, 
whether baselines or spectra, to be made.   
 
This is done as the wavelength range is scanned, and involves continuously 
adjusting the the high voltage on the photomultiplier to deliver the optimum 
photometric DC voltage via the electronics to the analogue to digital convertors. 
This high voltage control to maintain the photometric DC voltage is referred to as 
AutoPM. 
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Because of this process the detector gain will routinely vary during and between 
reference (baseline) and sample CD measurements so that the conditions for the 
normal absorbance calculation are not met.  
  
In order for Chirascan to deliver accurate absorbance spectra the following method 
has been developed which accounts for the variable gain element in the calculation. 
 
For a photomultiplier the current gain is given by the following equation (3): 
 

kn
kn

n

C

A HT
n
a

I
I

)1( �
  DP   (ii) 

 
where P is the current gain, IA and IC are the anode and cathode currents 
respectively, n is the number of dynodes in operation, k and a are constants 
dependent on photomultiplier design and material, D the collection efficiency and 
HT the applied high voltage. 
 
As described above during a scan a constant DC signal voltage is targeted, by 
varying the current gain of the photomultiplier. This is achieved by software 
control of the detector high voltage (HT). 
 
From equation (i) the reference and sample DC signals can be expressed as: 
 

       (iii) REFREFREF TfDC P. 

     (iv) SAMPSAMPSAMP TfDC P. 
 
where PREF and PSAMP are the two photomultiplier gains necessary to obtain DCREF 
and DC SAMP from the light transmitted by the reference and sample respectively (f 
represents an appropriate conversion constant dependent on the units of T).  
 
If, however, DCREF and DCSAMP are the same (which is the purpose of the AutoPM 
function) then the following holds: 
 

SAMPSAMPREFREF TT PP  .  
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and,  
REF

SAMP

SAMP

REF

T
T

P
P

  

therefore, 
REF

SAMPA
P
P

log  

 
Equation (ii) can be simplified to: 
 
   ZHTK )( P
 
for a particular detector where, 

 kn

n

n
aK

)1( �
 D  and  knZ  

therefore, 

  Z
REF

Z
SAMP

HTK
HTK

A
)(
)(

log  

Re-arranging this yields: 

  
)(
)(

log
REF

SAMP

HT
HT

ZA     (v) 

 
Z is the only constant photomultiplier-dependent term remaining and can be 
obtained easily by a simple calibration step. For a given detector and dynode 
configuration it is a dimensionless quantity between 5 and 6. 
 
Therefore under conditions where the same target DC level is achieved using the 
AutoPM function, equation (v) can be used to accurately calculate the absorbance 
from the detector high-voltage used for the reference and sample measurements. 
 
However, in practice, the AutoPM function returns when a signal DC level is within 
a tolerance window close to the target value. This lack of accuracy would introduce 
errors into the calculation above. However this error can be corrected by re-
introducing a term based on the classical calculation in equation (i).  
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From (i) (iii) and (iv), 
 

  
SAMPREF

REFSAMP

SAMP

REF

DC
DC

T
T

A
P
P

loglog    

 
 
 
Here we retain the individual DC terms for sample and reference to account for the 
AutoPM discrepancy .  
 
We can now derive the following: 
 

  
SAMP

Z
REF

REF
Z

SAMP

DCHTK
DCHTK

A
)(
)(

log  

and finally: 

  
SAMP

REF

REF

SAMP

DC
DC

HT
HT

ZA loglog �   (vi) 

 
This formula allows an accurate absorption to be calculated when the individual DC 
signal levels are recorded together with the detector high voltages. 
 
It can be seen that in the event of the HT being constant and the AutoPM function is 
not applied equation (vi) simplifies to the classical Absorbance calculation in 
equation (i). If the AutoPM function is perfect and the target DC signals are the 
same then only the left hand term applies and the calculation is the same as in 
equation (v). Any intermediate situation is accommodated through application of the 
full expression (vi). 
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Appendix B: Adaptive sampling 
 
B.1 Introduction 
 
Incoming signal data on the Chirascan is digitally averaged to reduce measurement 
noise. The raw signal is bandwidth limited before digitisation at a default frequency 
on all channels of 40kHz (max 100kHz). The signal to noise (s/n) improvement 
yielded by this averaging follows a square-root relationship to sample size (N) ie; 

   Nns v/    (i) 
 The averaging is carried out in the Windows� driver and can be controlled by the 
operator from the Chirascan control panel. The sample size for each average is more 
usefully expressed as a resulting time per point e.g. if N=40000 the time-per-point 
will be 1sec at a sample period of 25Psec.  Chirascan moves to, and stops at, each 
wavelength in the spectrum to carry out this sample average before proceeding to 
the next wavelength. The overall scan time is given by the following relationship: 
 
 Scan-time = (Time-per-point + step-time) x total wavelength-steps 
 
The step-time is a time overhead comprising a contribution from the time taken for 
the wavelength drive to move to the next wavelength and a short settling time prior 
to signal acquisition. It only becomes significant during rapid scans with minimal 
signal averaging. Total wavelength-steps is also equal to the product of the scan 
range and scan resolution (in steps/nm) plus 1. 
  
CD is a demanding technique due to the commonly very small magnitude of 'A to 
be measured (typically 10-4-10-5 AU) and the high degree of photon shot noise in 
regions of the spectrum where light throughput is limited. This means signal 
integration (averaging) over time is essential and scan times are typically of the 
order of several minutes, particularly when extending into the far–UV. The selection 
of a time-per-point is almost always going to be dictated by the adequacy of the 
noise reduction in this region of the spectrum and not by the less demanding 
requirements of regions of the spectrum where there is plenty of light (almost 
everywhere else).   
 
The result is that in some circumstances, in order to have adequate noise 
improvement in the far-UV much time will be spent averaging data elsewhere in the 
spectrum where it is not necessary. 
  



 

 1.16 Updated July 2004 

 
The purpose of the adaptive sampling option is to increase scanning efficiency by 
dynamically altering the data averaging sample size according to the light 
throughput as the scan proceeds.  
 
This unique feature of Chirascan is made possible by variable real-time digital 
signal averaging. 
 
B.2 The AutoPM function 
 
During a normal CD scan, the monochromator moves to successive points in the 
wavelength range of the scan. At each position the CD signal is optimised, by tuning 
the gain on the detector (by changing the applied high voltage). In the Chirascan 
software the AutoPM function performs this feedback control. It operates by 
increasing or reducing the HV on the detector until the optimum photometric DC 
voltage is achieved regardless of incident light intensity. This best matches the 
digitisation stage and results in the best quality CD resolution. In regions of the 
spectrum where there is a high photon flux (high light level) the required HV will be 
relatively low, whereas in regions of the spectrum where there is a low photon flux 
(for example in the far-UV) the HV will be increased.  Note at the very lowest light 
levels the HV will reach 1000 volts, which is the maximum permitted.   
 
It should be noted that when the HV has reached its maximum level, and the 
incident light continues to fall, the CD signal can no longer be further optimised.  
However, even with reduced signal levels a good CD signal can still be measured.  
A very high HV is not necessarily an indication that there is no CD signal. 
 
B.3 The adaptive sampling algorithm 
 
As explained in the introduction, adaptive sampling aims to optimise the overall 
scan time by spending more time collecting data where it is most needed, which 
means in regions of low light intensity, and to scan more quickly where light is 
plentiful.  
 
By reducing the number of samples (reducing the sampling time per point) in 
regions of high light flux, a spectrum can be measured in a shorter time.  Put another 
way, the use of adaptive sampling can lead to better spectra being measured in the 
same time.  With careful experimentation, using adaptive sampling can produce 
better CD spectra in a shorter period of time. 
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Although the relationships between HV, gain and photon noise are quite complex it 
is also true that, for a given detector, the observed photon noise amplitude is a direct 
function of the applied HV, and to a large extent independent of other instrumental 
parameters such as wavelength or bandwidth. By using the relationship in equation 
(i) it is possible at any HV to equalise the noise in averaged data by a suitable 
adjustment in the sample size i.e. as the light flux reduces and the HT rises, when a 
doubling of photon noise occurs this can be compensated for by a 4-fold increase in 
the average sample size. This is the basis of Chirascan’s adaptive sampling 
mechanism.  
 
Implementation of the approach required making measurements of the noise 
variance of a typical detector as a function of HV. Some sample results are shown 
below. A clear non-linear increase in signal variance with HT can be seen between 
200 and 1000 volts (the usual operating range of the detector). 

Detector noise vs HV (at constant photometric DC 
target)
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The data were then used to construct a plot of required relative average sample size 
required to maintain a constant noise level versus HV. Fitting an empirical formula 
to this data (ii) yields the continuous curve below enabling a relative sample size to 
be calculated for any HV. 
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To make use of this function we first define a default sample size and reference HV 
which act as the starting point for the adaptive algorithm. These values determine a 
default time-per-point and noise level which is broadly acceptable for typical 
spectral measurements into the far-UV, but which can be dynamically adapted by 
the algorithm to improve the scan efficiency as the light throughput varies. These 
values are the default sample size (20000 or 0.5 seconds time-per-point) and an HV 
of 800 volts.  
 
If adaptive sampling is not active and the scan proceeds, a 20000-point average will 
be calculated at every wavelength in the scan range.  
 
If adaptive sampling is selected then whenever the AutoPM function returns an HV 
of greater or less than 800 volts the sample size and therefore the sample time is 
increased or reduced according to the relative sample size function: 
 
     (ii) ))800.(003.( HVeY �� 
 
Thus at the reference HV of 800 volts, the adaptive sampling scaling factor Y is 1.0; 
at an HV of 500 volts, the sampling scaling factor is 0.407 and at an HV of 1000 
volts, the scaling factor is 1.82. 
 
So, at 1000V there would be roughly twice as much time spent acquiring each point 
as compared to the default time-per-point.  At HV levels of 500V, each point would 
be measured in roughly 40% of the default time. 
 
The net effect for a typical sample is that a scan should be faster with adaptive 
sampling than without for the same default sample size, particularly if the scan 
extends into high light throughput regions of the spectrum. This will be offset to 
some extent by increased time spent where light is limited – in the far-UV and in the 
presence of absorbing solvents - but here there will be a small enhancement to the 
signal to noise. 
 
It is also possible for the user to change the default number of samples and therefore 
the default time-per-point used during normal and adaptive sampling. Minimum and 
maximum sample sizes can also be modified to limit the sampling extremes during 
adaptive sampling. 
 
In conclusion, the adaptive sampling option will not always offer significant 
benefits, but with experimentation will result in scan time improvements for certain 
samples and scan wavelength ranges. 
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Appendix C: Data filtering 
 
C.1 Introduction 
 
Signals derived form photomultipliers inevitably have photon shot noise 
superimposed which is due to the random nature of photon detection events at the 
photocathode. This is of high frequency and gaussian in distribution and is usually 
the most significant type of random noise contributing to the overall noise in a CD 
measurment. Other sources of noise include electronic noise and noise which arises 
from the PEM modulation frequency 50kHz . 
 
There are three distinct forms of signal filtering which are implemented or available 
on Chirascan:  
 

- Signal bandwidth limiting and noise rejection in the analogue electronics 
- Post-acquisition signal averaging for shot noise reduction where signals are 

weak  
- Cosmetic smoothing of experimental results for presentation  

 
The first of these is an essential and optimized part of the processing of the raw 
analogue signals prior to digitization, whereas the second two are flexible and under 
operator control.  
 
C.2 Electronic filtering 
 
Firstly, prior to digitization of the analogue signals, it is important that signals are 
bandwidth limited to less than half the A/D sampling frequency (the Nyquist critical 
frequency) to prevent the aliasing of high frequency noise into the frequency 
spectrum of the measurement. This is well known from sampling theory (4) and is 
essential in any instrument which digitizes analogue signals at discreet intervals. A 
200Psec, 1kHz low pass filter on the CD channels (AC and DC) provides this 
filtering and also rejects any components of the PEM carrier frequency (50kHz).  
This fixed time-constant is the only pre-acquisition filter applied to the analogue 
signal and is not user adjustable.  
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C.3 Signal Averaging 
 
The digitized signals will still exhibit photon shot noise passed by the electronic 
filtering stage. This noise can often mask spectral features, or at least make them 
difficult to see, particularly in demanding regions of the spectrum such as the       
far-UV. Filtering of this noise is carried out primarily for cosmetic reasons   
 
The primary method of noise filtering over which the user has control is sample 
averaging. This is carried out following digitization but during the acquistion 
process and simply involves averaging digitized samples together. This yields a 
signal to noise improvement proportional to the square root of the number of 
averaged samples (see equation (i) in Appendix II). To prevent smearing of spectral 
information the monochromator moves to each wavelength in the scan and the 
sampling is carried out before the monochromator moves on to the next wavelength. 
The averaged measurement is then a true reflection of the input signal at that 
wavelength. This is in marked contrast to the application of variable time constant 
filtering during continuous scanning modes on earlier spectrometers. Here the 
smoothed result for a particular wavelength has a decreasing contribution from the 
signal at earlier wavelengths visited, to the point that spectral features can be 
skewed and attenuated during the process (see APL technical note).  
 
On Chirascan the average sample size is represented by a time-per-point parameter 
based on the current sampling period (default setting 25Psec). Because the 
wavelength drive pauses while the samples are collected, the size of the sample is 
directly responsible for the time spent per point and therefore the overall scan time. 
The user can adjust this parameter depending on the signal to noise required for the 
new spectrum and the time frame desired for the scan. However he or she can be 
confident that the resulting data are always an accurate representation of the original 
unfiltered data and that the noise reduction is statistically sound and free from the 
distortion risks which accompany the use of other online filtering methods. 
 
C.4 Cosmetic smoothing 
 
The acquired spectrum will probably still exhibit a degree of wavelength dependant 
noise which can be further reduced for enhanced visualization and publication 
purposes using off-line digital smoothing techniques. The digital smoothing method 
available in the Chirascan software is based on the Savitzky-Golay algorithm (4). 
Because such filtering methods can over-smooth the spectrum, distorting the 
underlying spectral features, the smoothed results are always accompanied by a 
display of the residual spectrum which is the difference between the smoothed and 
raw data. Any systematic deviation of this residual plot is evidence of  
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over-smoothing and the result should be discarded. A random residual indicates a 
smooth free from distortion (see below).    
 
 

Random residual following symmetrical digital smoothing. CD spectrum 
is not distorted.
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2.0 Introduction 
 
APL recommends that new users read this guide to familiarise themselves with the basic 
operation of the instrument. The operations covered are start up of hardware and 
software, use of the Chirascan instrument control and data acquisition software to 
collect CD spectra and baselines, use of the graphics software to carry out common 
operations on the data and to save data appropriately and conversion of data formats for 
export to third-party programs. 
 
2.1 Purging 
 
Removal of air from the light path by purging with nitrogen is essential, not 
optional. Failure to purge the instrument will result in the formation of ozone, 
which is damaging to health and can cause deterioration of the optical components 
in the instrument. 
 
The instrument is purged using clean nitrogen that is distributed to the instrument via a 
manifold that contains three gas flow controllers (see picture below). The gas pressure 
regulator of the master supply should be set in the range 2bar < P < 6bar, in accordance 
with the manufacturer’s recommendation. At first start-up, set the gas flow as high as 
the supply pressure allows, with most flow through the monochromator (middle) flow 
controller, and let the purge to continue for at least 15 minutes prior to attempting to 
ignite the lamp (see next section). After this initial, high-flow purge, the controllers can 
be set at 1 Lmin-1 -1 -1, 3 Lmin  and 1 Lmin  for the lamp housing, monochromator and 
sample housing respectively. 
 

 
Three rotameters (gas-flow controllers) control nitrogen flow to the lamp housing, 

monochromator and sample housing respectively, from left to right. 
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The lamp housing and monochromator are hermetically sealed, which means that once 
the initial purge is complete, you should not need to repeat the high flow-rate purge, 
unless the hermetic seals are broken (during service or lamp replacement) or if the 
instrument has been left idle for many days. 
 
NB It is essential that the nitrogen used to purge the instrument be clean. APL strongly 
recommends the use of a combined molecular sieve (X13) and activated charcoal gas 
trap, which will remove from the nitrogen stream all common impurities, which can 
otherwise deposit on the internal optical surfaces. The cleaner the nitrogen, the longer 
your Chirascan will maintain its far-UV performance. 
 
2.2 Power-up 
 
Ensure that the instrument is connected to the electricity supply and that it has been 
purged according to Paragraph 2.1. Put the two black rocker switches (System and 
Lamp) on the front panels to the on (I) position. The instrument will automatically 
check its zero positions (you may hear the monochromator motors moving). Ignite the 
Xe arc lamp by pressing the red Start button on the lamp control panel no sooner than 
10 seconds after the lamp power supply has been switched on – this is to allow 
sufficient time for the capacitors to charge up. If ignition is successful, the translucent 
panel on the source housing adjacent to the control panel will glow yellow; if you do 
not see a yellow glow, press the red Start button again; repeat until ignition is achieved. 
The lamp will require at least 15 minutes to stabilise following ignition. Finally, ensure 
that the computer, its monitor and printer are all powered up.  
 

 
The System panel 
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NB Once the lamp is struck, it is strongly recommended that it be left on for the 
duration of the work planned for the day. Repeated powering up and powering down 
will lead to instabilities (see previous paragraph) and will reduce the life of the lamp.  
However, if it is necessary to restart the lamp after running, it must be allowed to cool 
for about 15 minutes before re-ignition is attempted. 
 
The light-emitting diodes (LED) on the System panel are labelled Status, Tx and Rx; Tx 
and Rx will illuminate when commands are being transmitted or data is being received 
respectively; the green Status LED should be constantly illuminated – if it is flashing, it 
indicates that one or more of the electronics self-tests has failed. If this happens, try 
restarting the electronics and if the problem persists, please contact APL technical 
support. 
 

 
The lamp panel 

 
The red LED on the lamp panel indicates that power is present. The digital timer 
records the number of hours that the lamp has been running; adjacent to the timer is a 
recessed reset button: the timer must be reset when the lamp is changed. 
 
On shut-down, it is recommended that only the lamp be extinguished by putting the 
black rocker switch to the off (O) position. The electronics can be left switched on quite 
safely. Once the lamp is extinguished, the nitrogen should be left on for a few minutes 
while the lamp cools and because the lamp housing and monochromator are 
hermetically sealed, there will be little or no loss of purging integrity overnight or even 
over a weekend. Resuming normal nitrogen flow for 10 minutes after a weekend 
shutdown is usually sufficient to re-establish a fully purged light path. 
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2.3 Launching the software 
 
On starting the computer, among other icons on the desktop, you will see two associated 
with the Chirascan. They are called Chirascan and Pro-Data Viewer. Double-click on 
the Chirascan icon to launch the Pro-Data interface. 
 

 
The Pro-Data interface 

 
The Pro-Data interface enables you to configure the instrument and to manage 
experiments. It is divided into a number of sub-panels - Signal, Baseline, Sample 
Handling Unit, Monochromator, Sampling, Sequencer and Progress - in which are 
grouped the parameters relevant to the control or management of that sub-panel’s 
function. In addition, there is an unlabelled panel for controlling shutter function and 
detector high voltage.  
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2.3.1 Measuring a CD baseline and spectrum 
 
NB When you put a sample into the sample chamber, it is inevitable that a small 
quantity of air will be introduced to the low-volume light path within the purge tubes in 
the sample chamber. It takes only a few seconds to re-establish an air-free environment 
and you should not need to wait longer than that before starting your measurement. 
 
2.3.1.1 The CD baseline 
 
Every CD spectrometer has a CD baseline, caused by the interaction of circularly 
polarized light (CPL) with the slight birefringence found in the PMT detector window 
and to a lesser extent in the cuvette. To see the true CD spectrum of your sample, this 
baseline must be measured and subtracted from the CD spectrum of the sample. 
 
To measure the CD baseline, you must measure the CD spectrum of a blank. The blank 
must be identical in every way to the sample that you want to measure, except that the 
sample itself is absent. For example, if you intend to measure an aqueous solution of 
lysozyme in a 0.2mm path-length rectangular cuvette, then the CD baseline is 
determined using the same cuvette containing only water. 
 

 
Signal panel in the Pro-Data interface 

 
In the Signal panel, there is a drop-down menu that contains the main data collection 
modes: choose Circular Dichroism. In Options, choose either delta A (delta absorbance) 
or millidegrees, depending on the units in which you wish to express the CD 
measurement. Select Absorbance if you wish to simultaneously measure the absorbance 
spectrum of the sample. Note that Circular Dichroism, millidegrees and Absorbance are 
selected by default.  
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Monochromator panel in the Pro-Data interface 

 
Set the lower and upper wavelength limits of the scan range for your experiment in the 
Monochromator panel of the Pro-Data interface – these will normally be the same for 
both CD baseline and CD spectrum. For example, set Low to 180nm and High to 260nm 
if you are measuring a typical protein. Set the wavelength step size in Step, typically 
1nm or less, and click on Set. To the left of the monochromator wavelength bar, set the 
required bandwidth. Typically, a bandwidth of 1nm is suitable for protein CD 
spectroscopy. 
 

 
Sampling panel in the Pro-Data interface 

 
In the Sampling panel, set the time per point to the desired value. An approximate scan-
time is shown, which is approximately equal to the product of the time-per-point and the 
scan range divided by the step size. Note that the scan time will have a direct effect on 
the quality of the spectrum. If you are happy with this, with the blank in place in the 
sample holder, go to the Signal panel and click on Baseline. A CD baseline will now be 
measured; the display and data manipulation program Pro-Data viewer will 
automatically start and the data will be displayed; the data are stored as a file called 
Baselinexxxx.dsa (unless a different seed name has been specified – see later in this 
section) in your default working directory.  The Auto Subtraction tick box becomes 
active at the conclusion of a baseline scan: if you wish to subtract the baseline 
automatically from subsequently measured CD spectra, tick Auto Subtraction. 
 
NB. If Pro-Data viewer has been launched from the desktop independently of Pro-Data 
itself by clicking on its desktop icon, then Pro-Data will not know of the existence of 
the viewer – it is a separate program – and Pro-Data viewer will not respond to the start 
of an experiment in the normal way. To make the connection between the programs, go 
to Preferences>Go online… in Pro-Data Viewer and select Local in the dialogue box. 
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In general, when working at the instrument, it is recommended that you launch Pro-Data 

Viewer from Pro-Data using the  icon in the toolbar. This will ensure that local 
communication is established, that Pro-Data viewer will work correctly as a real-time 
display and that the data will be saved to a Datastore in the current working directory. 
 

 
Baseline CD spectrum 

 
You do not need to use the default name for the baseline – you can specify a seed name 

by clicking on the Seed Names icon  in the toolbar of the Pro-Data interface and 
specifying seed names for the baselines and the spectra. 
 

.  
Type in seed names of choice 
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2.3.1.2 The CD spectrum 
 
Once you have measured the CD baseline, replace the blank with your sample. As the 
conditions for the measurement of the sample will be identical to those for the blank, go 
straight to the Spectrum panel of the SPC and click on Start. The CD spectrum will be 
recorded under the conditions applied to the blank and stored as a file called 
Spectrumxxxx.dsa, unless you have specified a different seed name (see previous 
paragraph). 
 
The program Pro-Data viewer will automatically display the data as it is collected; an 
example is given below. Double-clicking anywhere in the graphics panel will autoscale 
the display. 
 

 

 
CD spectrum of lysozyme (raw data) 

 
When measuring any CD spectrum on Chirascan, other properties are simultaneously 
recorded. These include the voltage applied to the detector, the temperature and the 
absorbance spectrum of the sample. They can be viewed by selection from the Window 
menu. 
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2.4 Viewing and manipulating spectra 
 
If you have just measured a CD spectrum, the Pro-Data viewer launchpad and graphical 
display will be running and the CD spectrum will be displayed. If Pro-Data viewer is 
not running, launch it using the icon in the Pro-Data interface toolbar or, if the Pro-Data 
interface is not running either, from the desktop icon (see note at end of Section 
2.3.1.1). The program will open at the current working directory. You can change the 
location of the working directory by selecting or creating a different folder and using 
the Set Working Directory option from the Directory menu. The working directory is 
where new spectra will be saved. 
 

 
Pro-Data Viewer opens with two windows, the launchpad and the display 
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2.4.1 Viewing spectra 
 
With the Pro-Data viewer launchpad open, navigate in the usual way until you find the 
file of interest and double click on it. Pro-Data viewer displays the data contained in the 
file (below). 
 

 
CD spectrum of lysozyme (raw data) 

 
Double-click the left mouse button anywhere on the graphical display to autoscale the 
axes such that you see the full spectrum. To zoom in to a particular part of the display, 
click and hold the left mouse button whilst moving the cursor to create a box around the 
area of interest. On releasing the left mouse button, the newly-created box will expand 
to fill the display window. To return to the original display, simply double-click the left 
mouse button at any time. 
 
To zoom in or out in both x- and y-axes simultaneously, use the mouse-wheel; to zoom 
in or out in the x-axis only, use Ctrl in conjunction with the mouse-wheel; to zoom in or 
out in the y-axis, use Shift in conjunction with the mouse-wheel. 
 
Other properties are measured simultaneously with the CD spectrum and can be viewed 
by selecting the property of interest from the Window> New Window… menu. 
Alternatively, right-click on the y-axis label and choose the property from the pop-up 
menu that appears.  
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Choosing another property – here, absorbance will be displayed 

 
2.4.2 Comparing spectra 
 
If you wish to compare spectra, drag-and-drop the files of interest onto the graphical 
display window from the launchpad of Pro-Data viewer. More than one spectrum at a 
time can be dragged, using the usual combinations of Ctrl, Shift and mouse buttons. The 
spectra will be displayed in a single window. Note that the data sets must be compatible 
– you cannot overlay a trace collected as a function of wavelength with one that was 
collected as a function of some other variable, such as temperature. 
 
2.4.3 Manipulating spectra 
 
In the example below, there are six traces (3 repeat baselines and 3 repeat lysozyme 
spectra). The data used in this example can be found in C:\Program files\Applied 
Photophysics\Chirascan\Examples\Lysozyme spectra.  We will average the baselines, 
average the spectra, subtract the average baseline from the average spectrum, smooth 
the resulting baseline-corrected lysozyme spectrum and remove the original data. The 
end result will show the lysozyme spectrum and its residual (calculated minus observed 
spectrum).  
 
With the data loaded into the display as previously described and the display window 

active, press D or click on  to call up the Trace manipulation dialogue box. 
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Raw data with dialogue box called up 

 
The first three files are baselines; the second set of three are the lysozyme spectra. 
 

x Select the first group of three files and click Average. 
 
x Select the second group of three files and click Average. 

 
The files average::0  (average of the baselines) and average::1 (average of the spectra) 
will be added to the Visible Traces list and are plotted in the display. 
 

x Select the file average::0 and click Set Baseline. 
 
x Select the file average::1 and click Subtract Baseline. 

 
The file subtract::0 (baseline-subtracted spectrum) will be added to the Visible Traces 
list and is plotted in the display. 
 

x Select subtract::0 and click on Smooth. A new dialogue box will appear. 
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Example of an appropriate smooth (left, noise randomly distributed about zero) and an 

inappropriate one (right, structure in the residual caused by differences between 
calculated and observed spectra) 

 
In the Window Size box, type an integer whose value will depend on the step resolution 
used during the measurement and the sharpness of the features in the spectrum. The 
number should be as large as is possible without distorting the spectrum. Examination 
of the residual plot will show if any distortion has occurred. If the noise is randomly 
distributed about zero, the smoothing process has not caused any distortion and, 
importantly, you have the evidence to prove it. When you are satisfied with the 
smoothing process, click OK. 
 

x Click Unset Baseline. 
 

x Select Smooth (s):0 and Smooth (r):0 and click Remove Others. 
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x Click OK to close the dialogue box. The result of the above manipulation is 
shown below. 

 

 
Lysozyme – a smoothed, baseline-corrected spectrum with its residual. 

 
Note that even after closing the Trace Manipulation dialogue, any removed traces are 
remembered. Should you wish to carry out further manipulation, simply re-open the 
dialogue and all the traces will be listed, whether visible or removed, enabling you to 
carry on where you left off. 
 



 

 2.17                      Updated October 2006 

 
2.5 Saving data 
 
If you have performed operations in Pro-Data viewer (e.g. smoothing, averaging or 
baseline subtraction), added comments, or altered the data in any other way you may 
want to save the results of the manipulation. 
 
The manipulated data are not saved automatically. To save the result, go to File>Save 
Current Plot… (keyboard shortcut Shift+S) to call up the Save As… dialogue box or 
File>Save selected traces (Ctrl+Shift+S). The original raw data are never over-written. 
The results of any manipulation are stored in a new Datastore and a complete history of 
the manipulated traces is contained in the History of that Datastore, an example of 
which is shown below. 
 

 
 
2.5.1 Exporting data from Pro-Data 
 
Right-click on a filename in the Pro-Data viewer launchpad to display the pop-up menu 
shown below. 
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Select Export data… and choose an appropriate format for export to another program 
 

 
 
CSV format is suitable for third-party programs such as Excel; please note, other file 
options relate to file formats derived from other APL products. 
 
2.5.2 Converting data for use with third-party programs 
 

 This icon is installed on your desktop and will start the APL data converter. 
 

 
 
The APLDataConverter program has explicit instructions written in the window. In 
default configuration, it will convert one or more DataStore (Chirascan) files into 
spreadsheet-friendly comma-separated-variable (.CSV) files that will be written back to 
the same directory as the original files, which are left intact. The .CSV files can be 
loaded into any program that accepts the .CSV format (e.g. Excel and Lotus 123). To 
find out more about the use of the APLDataConverter, run the program and press F1. 
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2.6 Printing 
 
The Print icon in Pro-Data viewer will print the current Pro-Data viewer display and, 
optionally, the principal experimental parameters, any comments you have added to the 
file and its history. 
 
2.7 Operating notes and hints 
 
2.7.1 Selecting Step Size (SS) 
 
The step size will determine the number of data points that make up a spectrum.  For a 
given time per point, larger step sizes will reduce the overall scan time of an experiment 
but will reduce the resolution of the spectrum; smaller step sizes will improve the 
resolution of a spectrum but it will take longer to run. 
 
An appropriate step size can be chosen using the equation: SS = FWHH/20, where 
FWHH refers to the full width at half height (in nm) of the narrowest peak in the 
spectrum. 
 
Guidelines: samples in solution: 0.2nm <  SS < 1nm 
  gas or vapour samples: 0.1nm < SS < 0.5nm 
 
Specific examples are given in Section 8. NB Analysis of protein spectra using the 
public domain software CDNN requires a 1 nm SS. 
 
2.7.2 Selecting Spectral Bandwidth (SBW) 
 
The spectral bandwidth should be selected to maximise the light reaching the sample, 
without compromising spectral resolution. For a given signal-to-noise ratio, a narrower 
bandwidth will take longer to run but will reveal spectral fine structure; a wider 
bandwidth will permit you to run the spectrum more quickly but may lose detail. 
 
Guidelines: samples in solution: 0.5nm < SBW < 2nm 
  gas or vapour samples: 0.1nm < SBW < 0.5nm 
 
Specific examples are given in Section 8. 
 
In the far-UV, increasing the bandwidth can be essential if you have a highly absorbing 
sample. Doubling the SBW increases fourfold the number of photons reaching the 
sample. The maximum bandwidth varies with wavelength because of the non-linear 
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dispersion of light by prisms – dispersion increases (and therefore maximum bandwidth 
decreases) with decreasing wavelength. The SBW ranges for the shorter wavelengths 
are given in the table below.  
 
 

Wavelength SBW range 
170nm 0.1nm < SBW < 3nm 
180nm 0.1nm < SBW < 4nm 
200nm 0.1nm < SBW < 6nm 

 
2.7.3 Selecting pathlength and concentration 
 
The pathlength and concentration of a sample should be chosen so the absorbance value 
at any given point in the spectrum does not exceed 2 absorbance units (AU). It is good 
practice to run a simultaneous absorbance scan when performing a CD experiment in 
order to verify that the absorbance does not significantly exceed this limit. Ideally, the 
total absorbance should not exceed 1.2AU. 
 
If the absorbance exceeds the upper recommended limit, you may wish to use a lower 
pathlength cell or dilute the sample; conversely, if there is insufficient absorbance to 
generate a reliable CD signal, you may wish to use a longer pathlength cell or increase 
the concentration of the sample.  
 
2.7.4 Selecting time per point 
 
The time per point is the time taken sampling data for each step.  Collected data at each 
point are averaged to improve the ratio of signal-to-noise.  If the noise levels are too 
high, then more data points will need to be averaged – increase the time per point.  This 
parameter needs to be selected in conjunction with the spectral bandwidth and step size 
of a scan, as all these factors play an important part in determining the scan time and in 
optimising spectral quality.  Examples of suitable parameters for many common types 
of experiment have been included in Section 10. 
 
Guidelines: A doubling of the time per point will result in a �2 reduction in the 

noise.  A tripling of the time per point will result in a �3 reduction in 
the level of noise, and so on. 



 

 2.21                      Updated October 2006 

 
2.7.5 Nitrogen purge flow-rate 
 
It is essential that the system be purged with nitrogen constantly whilst the lamp is on.  
Failure to do this will result in the formation of ozone, which is damaging to health and 
to the optical components in Chirascan (see Section 2.1). 
 

 N2 flow-rates* (start-up) Lmin-1 N2 flow-rates (normal) Lmin-1

Lamp housing  4 1 
Monochromator 10 3 
Sample chamber 2 1 
Total 16 5 
 
It is only when the lamp housing or monochromator seals are broken that the higher 
flow-rates are required. Unless the instrument has been left idle and unpurged for many 
days, 10 minutes of purging at the normal flow-rates will be sufficient to establish an 
oxygen-free atmosphere. 
 
*The maximum flow rate will be determined by the source pressure.  If the pressure is 
significantly below the maximum 6 bar, then it might not be possible to achieve the 
listed flow rates. If that is the case, set the flow rates to the highest possible, directing 
the majority of flow through the monochromator. 
 
2.7.6 Measuring protein spectra. 
 
Measuring the CD spectra of proteins is perhaps the most common use to which the 
Chirascan will be put. In the following paragraphs are some hints and tips on how to 
ensure that your protein CD spectra are of the highest quality. It is not possible to cover 
all contingencies but these guidelines will, it is hoped, get you in the right ball-park. 
 

Lower wavelength limit Solvent Pathlength Protein concentration 
180nm H2O, dilute buffer or D2O � 0.5mm 0.2 – 0.5 mg/mL 
175nm H2O or D2O � 0.2mm 0.5 – 1.0 mg/mL 
170nm D2O � 0.1mm 1.0 mg/mL 
  

1) Use a short pathlength if measuring into the far-UV. See above table for 
recommendations. 

2) Use a bandwidth � 1nm to ensure the detector is working in a linear regime, 
especially as you go to the near-UV where samples absorb less light. With the 
sample in place, the detector high-voltage should not drop below 200V. If it 
does, reduce the bandwidth. 
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3) If you wish to go below 180nm, consider using heavy water – it absorbs less 
than normal water and is not expensive – buy NMR-standard D2O from a 
reputable supplier. 

4) If you wish to go to 170nm – and these are very difficult experiments to 
perform – you will have to employ a cell with a pathlength � 0.1mm and use 
heavy water. 

5) Use degassed solvent to prevent bubble formation in the cell (and to remove 
oxygen). 

6) Ensure the instrument is purged properly with nitrogen. Flows of 1L min-1, 
-1 -13L min  and 1L min  for the lamp, mono and sample will be perfectly 

adequate, even for the very short wavelength measurements. 
7) It is a good idea to separate the absorbance of cell and solvent from sample. 

The best way to do this is to measure a baseline with no sample or cell in 
place, then measure the blank as a sample. That would give you the CD 
baseline and an absorbance spectrum of the blank. Finally measure your 
sample. You would then have the CD spectrum of your sample, a baseline to 
subtract from it, the total absorbance of sample, solvent and cell and the 
absorbance of solvent and cell only. Subtracting solvent and cell from total will 
give you the absorbance of the sample only. The reason for doing this is that 
you will find out that water – or buffer or D2O – absorbs very strongly as you 
approach and go below 180nm. It is important that you keep the total 
absorbance within reasonable bounds. If you keep your total absorbance below 
2AU, you should be OK. 

8) Remember than photodegradation of your sample will occur if you use an 
unnecessarily high intensity beam. 

 
2.8 Example spectra. 
 
There are several files installed on the hard disk that can be used as templates to set up 
the Pro-Data interface or as tools to familiarise oneself with the use of Pro-Data viewer. 
The files are held in 
 
C:\Program Files\Applied Photophysics\Chirascan\Examples\ 
 

and can be accessed using the  icon from the Pro-Data interface toolbar and in 
Pro-Data viewer by navigating to the directory in the launchpad. 
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2.8.1 Alcohol dehydrogenase 
 

 
 

Scan range 260 – 175 nm 
Spectral bandwidth 1 nm 
Step size 0.5 nm 
Pathlength 0.1 mm 
Concentration 1 mg/mL 
Solvent Water 
Time per point 3 s 
Total N2 flow 5 Lmin-1 
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2.8.2 Bovine serum albumin 
 

 
 

Scan range 260 – 175 nm 
Spectral bandwidth 1 nm 
Step size 0.5 nm 
Pathlength 0.1 mm 
Concentration 1 mg/mL 
Solvent Water 
Time per point 3 s 
Total N2 flow 5 Lmin-1 
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2.8.3 Cytochrome C 
 

 
 

Scan range 260 – 175 nm 
Spectral bandwidth 1 nm 
Step size 0.5 nm 
Pathlength 0.1 mm 
Concentration 1 mg/mL 
Solvent Water 
Time per point 3 s 
Total N2 flow 5 Lmin-1 
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2.8.4 Lysozyme 
 

 
 

Scan range 260 – 185 nm 
Spectral bandwidth 2 nm 
Step size 0.5 nm 
Pathlength 0.5 mm 
Concentration 0.2 mg/mL 
Solvent Water 
Time per point 1s, 3-scan average 
Total N2 flow 5 Lmin-1 
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2.8.5 Vitamin B12 
 

 
 

Scan range 600 - 200 nm 
Spectral bandwidth 1 nm 
Step size 1 nm 
Pathlength 1 mm 
Concentration 1 mg/mL 
Solvent Water 
Time per point 2 s 
Total N2 flow 5 Lmin-1 
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2.8.6 Tris(ethylenediamine) cobalt chloride 
 

 
 

Scan range 800 - 250 nm 
Spectral bandwidth 1 nm 
Step size 1 nm 
Pathlength 10 mm 
Concentration 1 mg/mL 
Solvent Water 
Time per point 0.5 s 
Total N2 flow 5 Lmin-1 
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2.8.7 Camphor sulphonic acid 
 

 
 

Scan range 300 - 180 nm 
Spectral bandwidth 0.5 nm 
Step size 0.5 nm 
Pathlength 1 mm 
Concentration 0.6 mg/mL 
Solvent Water 
Time per point 1.75 s 
Total N2 flow 5 Lmin-1 
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2.8.8 (R)-3-methylcyclopentanone 
 

 
 

Scan range 350 - 175 nm 
Spectral bandwidth 0.1 nm 
Step size 0.1 nm 
Pathlength 10 mm 
Concentration Vapour 
Solvent - 
Time per point 1 s 
Total N2 flow 5 Lmin-1 
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2.9 Troubleshooting 
 
If the instrument does not operate properly, please use the following table to eliminate 
trivial causes of incorrect function. There is also a ‘frequently asked questions’ section 
on the website (http://www.photophysics.com/faqch.php) to which you should refer if 
the table below does not help. If the symptoms persist, please contact Applied 
Photophysics Technical Support (contact details at front of manual) with a detailed 
description of your difficulty and the name of your spectrometer. Each spectrometer has 
a name that can be found at the front of the manual and on the front of the 
monochromator. 
 

Symptom Cause Corrective action 
Check that all power cables are correctly 
plugged in and that the power at the mains 
outlet is switched on. 

Instrument / computer 
cannot be switched on. 

No power available. 

Check that all supply fuses are intact. 
No light - xenon lamp is 
not ignited. 

Put the rocker switch in the ‘I’ (on) position 
and press the red ignite button. 

No light - shutter is in the 
closed position. 

Use the Ptro-Data interface to Open the 
shutter. 

No light – slits too narrow 
or closed. 

Check the bandwidth in the 
Monochromator section of the Pro-Data 
interface and set the bandwidth to a 
reasonable value, e.g. 1nm 

No HV on the detector. In this case, light might be reaching the 
detector but without any high voltage 
applied to the detector there will be no 
signal. Check the detector cable is 
correctly connected and then use the Pro-
Data interface to Restore the HV. 

No light – sample is 
opaque. 

Reduce concentration and / or pathlength 
of sample and / or buffer. 

No detector signal. 

No light in far-UV – 
instrument is not purged. 

Oxygen absorbs light at wavelengths 
below 190nm. Ensure that the purge tubes 
are connected at both ends, that there is 
nitrogen available and purge the 
instrument with clean nitrogen. 

Bandwidth too narrow Check the bandwidth in the mono section 
of the Pro-Data interface and set it to a 
reasonable value, e.g. 1nm. 

Sample or buffer is highly 
absorbing. 

Reduce concentration and / or pathlength 
of sample and / or buffer. 

Lamp is old. If the lamp has been run for more than 
1,000 hours, its output, especially in the 
far-UV, will be low. Replace lamp. 

Unstable line voltage Use stabilised supply. 

Signal is too noisy. 

Electromagnetic 
interference from nearby 
equipment. 

Remove the source of noise from the 
proximity of the spectrometer. 
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Notes 
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3.0 Launching Pro-Data  
 
Pro-Data is a program whose primary purpose is to control the spectrometer and its 
accessories and to acquire data. It is launched by clicking on the desktop icon (see 
above). The Pro-Data interface will appear on the screen. 
 

 
 
The interface, called the spectrometer control panel (SCP), enables you to provide 
instructions to the spectrometer so that it carries out an experiment or a series of 
experiments according to your requirements. The interface is supplemented by 
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drop-down menus for the management of files or the launching of associated programs. 
Shortcuts to the most commonly used items from the drop-down menus are provided by 
the toolbar icons. 
 
3.1 The signal panel 
 

 
 
You can choose from four modes of data collection from the drop-down menu in the 
Signal panel: Circular Dichroism, Fluorescence, Absorbance and Voltage. The Signal 
panel changes appearance to reflect the mode of data collection. Each is described 
below. Common to each of the four Signal panels is an oscilloscope-style live display 
that can be launched by clicking on the icon in the top right corner of the panel. The 
units will be those of the chosen measurement mode; an instantaneous value of the 
measurement is also displayed in the box to the right of the drop down menu.  
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3.1.1 The circular dichroism panel 
 

 
 
The most commonly used mode of data collection is Circular Dichroism. The CD panel 
has two sub-panels, Options and Baseline. In Options, choose either delta A (delta 
absorbance) or millidegrees for the units of the CD measurement. Select Absorbance if 
you wish to simultaneously record an absorbance spectrum of the sample 
(recommended). In CD mode, the absorbance is derived from the detector HT and 
although fairly accurate, you might find that it differs slightly from an absorbance 
measurement taken in Absorbance mode on Chirascan or a measurement taken on a 
dedicated UV-visible absorbance spectrometer. It is intended only to show that the 
absorbance is within reasonable bounds for a CD experiment and in general, the total 
absorbance of the sample and its buffer / solvent should be <1.5AU. Note that CD, 
millidegrees and Absorbance are selected by default.If you prefer delta A, you can set 

delta A to be the default in View>Preferences>CD (toolbar  ). 
 
If Chirascan is equipped with a fluorescence accessory, the Fluorescence tick-box will 
be active; if not, the Fluorescence tick-box will be inactive. In the case of the former, if 
you wish to measure fluorescence and CD simultaneously, tick Fluorescence. 
 
The Baseline panel is used to measure a CD baseline. Clicking on Baseline will initiate 
a CD measurement using the experimental parameters defined elsewhere in the 
interface. Pro-Data viewer will be launched automatically and the display will show the 
CD baseline trace. The measurement can be stopped at any time by clicking Stop, which 
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is the label that appears on the Baseline button during a measurement; it can also be 
Paused and Resumed, using the buttons in the Sequencer panel (see Section 3.5). At the 
end of the measurement, the baseline will be stored as Baselinexxxx.dsa, unless a 
different seed name has been specified (View>Preferences>Seed names, toolbar 

). If the filename already exists, a Save As panel will open in the current working 
directory and you can save the data with a different name or in a different location. The 
Auto Subtraction tick box becomes active at the conclusion of a baseline scan: if you 
wish to subtract the baseline automatically from subsequently measured CD spectra, 
tick Auto Subtraction. 
 
Show… is used to reinstate a previously-measured CD baseline. It calls up a dialogue / 
preview box that enables you to load any baseline file.  

 

 
 
Click on Recall Last to reinstate the most recently measured baseline; click on Load… 
to browse for other baseline files. The chosen file will appear in the preview window. 
The Smooth button will smooth the trace, which is useful if you wish to subtract a single 
baseline from a number of spectra that are to be averaged. Under these circumstances, 
smoothing prevents reinforcement of the baseline noise in the final result (see Appendix 
2). Save… and Print… have their usual functions. Click on OK to confirm your choice 
and close the dialogue box or Cancel to close without implementing the new baseline. 
 
Calibration is used to recalibrate the CD scaling factor and requires administrator 
privileges to gain access to it. It should not be necessary to use it routinely and will be 
greyed out for the normal user. Please refer to Section 3.13 if you wish to recalibrate the 
CD. 
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3.1.2 The fluorescence panel 
 

 
 
The descriptions that follow assume that you have the required fluorescence accessories 
and that they have been correctly installed. 
 
3.1.2.1 Measuring a fluorescence excitation spectrum 
 
If you are using the total fluorescence accessory, ensure you have an appropriate filter 
in place and leave Emission mono unselected.  
 
In the Mono panel of the SCP, set the monochromator parameters to reflect the 
wavelength range and bandwidth needed for the experiment (see Section 3.3); likewise, 
in the Sampling panel, set an appropriate time per point (see Section 3.4). 
 
The measurement of a fluorescence excitation spectrum requires the setting of a suitable 
high voltage on the fluorescence detector which in turn requires some knowledge of the 
fluorescent behaviour of the sample. If it is a sample type you know, set the Chirascan 
monochromator to the excitation wavelength that generates the maximum fluorescence 
intensity. If it is a sample with which you are not familiar, make an exploratory scan   
over the desired range of excitation wavelengths with an arbitrary (say 750V) high 
voltage on the fluorescence detector to find out where the maximum fluorescence is. To 
set a high voltage, click on the PMU button to open a dialogue box (below); set the HV 
and select Instant effect. Click on OK to close the dialogue box. 
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Once the excitation wavelength that corresponds to the maximum fluorescence intensity 
has been found, click on AutoPM, in the Fluorescence panel - this will adjust the 
detector high voltage so that it is at the optimum level for the Chirascan electronics. The 
detector is now set correctly and a fluorescence excitation spectrum can be measured. 
Click on Acquire in the Sequencer panel. 
 
3.1.2.2 Measuring a fluorescence emission spectrum 
 

 
 
Selecting Emission mono in the Options panel enables you to measure a fluorescence 
emission spectrum, which requires the emission fluorescence accessory. The 
Monochromator panel changes to give control of the emission monochromator. The 
excitation wavelength is set in the Excitation mono panel and the parameters governing 
the wavelength range and step-size of the emission monochromator are set in the 
Emission mono panel. 
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As was the case for excitation spectra, the setting of a suitable high voltage on the 
fluorescence detector requires some knowledge of the fluorescent behaviour of the 
sample. If it is a sample type you know, set the excitation wavelength in the Excitation 
mono panel and set the Emission mono at the wavelength known to generate maximum 
fluorescence intensity. If it is not a sample about which you know anything, you will 
need to run an exploratory scan with the emission monochromator to establish the 
maximum intensity emission fluorescence for a given excitation wavelength. Once the 
emission wavelength that corresponds to the maximum intensity has been found, click 
on AutoPM, in the Fluorescence panel which will adjust the detector high voltage so 
that it is at the optimum level for the Chirascan electronics. The detector is now set 
correctly and a fluorescence excitation spectrum can be measured. Click on Acquire in 
the Sequencer panel. 
 
If the AutoPM set-up described above yields a detector voltage setting that is not 
suitable to measure a reasonable spectrum, set the monochromators at the required 
excitation wavelength and the maximum intensity emission-wavelength respectively, 
click on the PMU button to open the window shown above and set the detector voltage 
manually as previously described. 
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3.1.2.3 Using the emission accessory to measure an 
excitation spectrum 
 
When using the total fluorescence accessory, a suitable filter is used to exclude scattered 
excitation light which, if it were to reach the detector, would compromise the result. The 
emission monochromator can be used instead of a filter – it can be set at a wavelength 
and a bandwidth that would exclude scattered excitation light. To do this, select 
Emission mono and Excitation scanning from the Options panel. 
 

 
 
The Monochromator panel changes to reflect the use of the emission mono as a filter. 
The excitation wavelength range and bandwidth is set along with the emission 
wavelength. Note that bandwidth is set manually on the emission monochromator. 
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3.1.3 The absorbance panel 
 

 
 
In Options, you can choose which units you prefer – Absorbance or Transmission. If the 
fluorescence accessory is present, you will optionally be able to record a simultaneous 
fluorescence excitation spectrum by selecting Fluorescence and using PMU… to set a 
suitable voltage on the fluorescence detector (see Section 3.1.2.1). 
 
The Baseline panel is used to measure a reference baseline relative to which the 
absorbance of the sample is calculated. Selecting Auto HV in Baseline will optimise the 
high voltage applied to the detector for every point in the baseline scan. These values 
are remembered and applied at each corresponding point in the subsequent absorbance 
scan, allowing an accurate absorbance spectrum to be recorded easily. Clicking on 
Baseline will initiate a baseline measurement using the experimental parameters defined 
elsewhere in the interface. The measurement can be stopped at any time by clicking 
Stop, which is the label that appears on the Baseline button during a measurement. At 
the end of the measurement, the baseline will be stored as Baselinexxxx.dsa, unless a 
different seed name has been specified. 
 
With the baseline measured, insert the sample and click on Acquire in the Sequencer 
panel to measure an absorbance spectrum.  
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3.1.4 The voltage panel 
 
N.B. This panel is intended for diagnostic purposes only. It is unlikely that you will 
need to use it in the normal course of events. 
 

 
 
The five signal channels currently assigned are auxiliary1, auxiliary2, fluorescence, 
circular dichroism DC and circular dichroism AC. Only those that are actually installed 
will be highlighted in the Voltage panel; the others are greyed out. 
 
When in voltage mode, channels 1 to 4 operate in a similar fashion: each provides a 
voltage scan proportional to the intensity of a signal falling on the detector 
photocathode at a fixed detector high-voltage. This allows sensitivity checks and 
elementary voltage scans to be performed for diagnostic purposes. For example, you 
could use the fluorescence channel to determine where the maximum intensity of a 
fluorescing sample occurs (see Section 3.1.2 et seq.) or the CD DC channel in the 
absence of a sample to look at the lamp profile.  
 
Channel 5, the CD AC channel, gives access to the voltage arising from the polarization 
modulation induced by the photo-elastic modulator. It is non-zero only in the presence 
of a sample with a chiral chromophore (or if a birefringent medium is placed in the path 
of the modulated CPL). The information measured with this channel is subsequently 
used in conjunction with the information from the CD DC channel to derive the circular 
dichroism of the sample. 
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3.2 The shutter / attenuator panel 
 

 
 
This part of the SCP controls the shutter/attenuator mechanism. 
 
The shutter/attenuator can be opened or closed by clicking on the Open and Close 
buttons.  A picture showing a representation of the shutter provides feedback on the 
current status of the shutter/attenuator. Black is closed and yellow is open. 
 
Click on Zero HV to set the HV on the detector to zero. With zero voltage on the 
detector, the button will read Restore HV – click on it to restore the high voltage to its 
previous value. Use this before disconnecting or reconfiguring detectors. 
 
AutoShutter automatically opens and closes the shutter during instrument operation.  If 
the AutoShutter check box is not checked, then the Chirascan will not open the shutter 
at the start of a scan, nor close it at the end of a scan.  However, if the shutter is closed 
at the start of a scan, the user will be presented with a warning message. 
 
AutoShutter is selected by default. This provides automatic opening of the shutter at the 
start of a scan and closes it at the end.  It also closes the shutter while waiting for the 
temperature to stabilize during temperature-ramp experiments or during titration 
experiments when waiting for titrant to be added. The main purpose of Autoshutter is to 
minimise the exposure time of a sample to intense radiation. 
 
3.3 The monochromator panel 
 

 
 
The Monochromator panel of the interface provides access to the parameters that 
control the operation of the Chirascan monochromator. Here you set the scan range,  
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step-size and bandwidth for your experiment; you can also move the monochromator to 
a specific wavelength. 
 
To drive the monochromator to a specific wavelength, use the Wavelength (nm) edit box 
and hit return on the computer keyboard; to set the bandwidth, use the Bandwidth (nm) 
edit box and hit return. Setting wavelength and bandwidth can be done simultaneously 
with a single return. 
 
To set the wavelength range for a scan, use the Low and High edit boxes to set the lower 
and upper wavelength limits; use the Step edit box to set the step-size; all units are 
nanometres. Click on the Set button or hit return to confirm these parameters. Note the 
Chirascan always scans from high to low wavelength. 
 
To save the current monochromator parameters as the default ones, click on the Adv… 
button, which displays the Monochromator Wavelength Setup - Advanced panel and 
click on Save As Default. Click on OK to take you back to the Pro-Data interface. 
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3.3.1 Advanced mono setup – discrete wavelengths 
 
The first panel in Advanced is the Single wavelength panel. Select Single wavelength 
and specify the wavelength in the associated dialogue box. Click on OK. The Advanced 
panel will close and when you click on the Start button in the Spectrum panel of the 
interface, the monochromator will drive to the selected wavelength and measure the CD 
or other chosen property of the sample at that wavelength. Such single wavelength 
measurements are useful when following a change in property as a function of some 
independent variable other than wavelength - temperature, for example. 
 
It is possible to create a list of discrete wavelengths. Firstly, clear the wavelength list by 
clicking on Clear list and then select Append to list. Now select Single wavelength, 
specify the wavelength in the dialogue box and click on Generate list. Each time you 
type in a wavelength and click on Generate list, the specified single wavelength will be 
appended to the list. When you are satisfied that the list of wavelengths is correct, click 
on OK. When you click on Start in the Spectrum panel of the interface, the 
monochromator will drive to the selected wavelengths in the order they appear in the list 
and measure the CD or other chosen property of the sample at those discrete 
wavelengths. 
 
3.3.2 Advanced mono setup – skip-scans 
 
NB. A simple wavelength range can be set in the Monochromator panel and there is no 
need to use the advanced panel to set such a range (see Section 3.4). However, if you 
wish to carry out a more sophisticated scan, select Wavelength range in the Advanced 
panel. Then clear the wavelength list by clicking on Clear list and then select Append to 
list. Specify the Start, Stop and Step values for the first wavelength range and click on 
Generate list. A number of entries that correspond to your specification will appear in 
the list. Then enter the Start, Stop and Step values for the second range and click on 
Generate list once more. The new values will be appended to the existing values in the 
list. Repeat this cycle until you have completed the skip-scan list. The total number of 
entries in the list is recorded at the foot of the list. 
 
Skip-scans are in general used on samples that you know well and that you might wish 
to measure again in the future. Use the Save As… button to save the list as a .conf 
(configuration) file that can be retrieved using the Load button at a future date. This 
obviates the need to generate a new list every time you run the sample. 
 
With the list generated, click on OK to return to the SCP. When you click on Acquire in 
the Sequencer panel, the monochromator will drive to the wavelengths specified in the  
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list in the order in which they appear in the list and the instrument will measure the 
specified property (CD, voltage, fluorescence etc.) at those wavelengths. 
 
3.4 The sampling panel 
 

 
 
The Sampling panel is used to control the sampling time for each point in a scan. Use 
the Time-per-point (s) edit box to specify the time in seconds to be spent collecting data 
at each point; an approximate scan-time is calculated from the product of the time-per-
point and the number of points in the scan (specified in the Monochromator panel). 
 
If the Enable Adaptive Sampling box is ticked, the time-per-point is varied inversely as 
a function of light reaching the detector. Where the signal is weaker, more time is spent 
collecting data than where it is stronger. The algorithm has been developed such that it 
will usually take less time to measure a spectrum than at constant time-per-point.  
 
Clicking on the Adv… button calls up the Sampling – Advanced dialogue. 
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The Sample period (Ps) can be set at any value between 10.0Ps and 1000.0Ps in the edit 
box, followed by clicking on the Apply button; the Default number of samples can be set 
anywhere between the minimum and maximum limits (see Sampling limits below). The 
product of the sample period and the number of samples yields the current time per 
point. The default number of samples is superseded by changing the Time-per-point in 
the Sampling panel, as described above. Selecting Disable oversampling will do 
precisely what it says and is used for diagnostic purposes only. If it is selected, a 
warning is given (below); for all non-diagnostic use, oversampling must be used. 
 

 
 
Sampling limits can be changed but the default values are best suited to routine 
operation. The minimum time-per-point will be 25Ps multiplied by 10 samples, i.e. 
250Ps; the maximum time-per-point will be 25Ps multiplied by 4000000 samples, i.e. 
100s. These limits apply to all experiments, whether set up using constant time-per-
point or using adaptive sampling; they are particularly useful in placing limits on the 
extremes of adaptive sampling. 
 
3.5 The sequencer panel 
 

 
 
The Sequencer panel allows you to specify the type of measurement you will make and 
to control the starting, stopping, pausing and resuming of data acquisitions. You can run 
repeats of the same experiment by ticking the Repeats box and entering the number of 
repeats in the edit box adjacent. You can specify delays between individual 
measurements in Timed intervals; all data will be written to a single Datastore.  
 
The radio buttons allow you to select the type of measurement you will carry out. It will 
usually be Spectrum for Chirascan. 
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Acquire begins an acquisition according to the instructions in the SCP; Stop (which 
appears after Acquire has been selected) will abort the acquisition; Pause will stop the 
acquisition without aborting and Resume (which appears after Pause has been selected) 
will restart the acquisition from the point at which it was paused. 
 
3.6 The progress and status panel 
 

 
 
The Progress and Status panel provides information concerning the current status of the 
spectrometer and of data acquisition. The box on the left of the panel will give the status 
(e.g. Ready, Stirring, Acquiring); the two bars to the right of the panel give a visual 
representation of the progress. 
 
3.7 The temperature control panel 

 

 
 

When a peltier temperature controller or a recognized circulator is installed (see 
Devices), the Temperature Control Unit panel will show the temperature reading of the 
sensor associated with the cooling / heating device and the Settings button will become 
active, as shown in the above figure. Clicking on the Settings button displays the 
Temperature Control window (see below), which is used to set up the temperature 
controller. 
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If you wish to set the sample at a particular temperature, type the temperature in the edit 
box of the Set Point (oC) panel and click on the Set button. 
 
If you wish to carry out a temperature ramp experiment, such as the thermal 
denaturation of a protein, tick Enable ramping. The panel will become active and you 
can specify the Start, Stop, Step, Rate and Tolerance in the edit boxes provided. All 
temperatures are oC.  
 
If you wish to specify what should happen at the end of the temperature ramp 
experiment, tick At the end of temperature ramp go to: in the End-of-ramp behaviour 
panel.  The three choices will become active and by clicking the appropriate button, you 
can choose Start temperature, Stop temperature or Specified temperature, which you 
type into the edit box adjacent to the button. In the above figure, the Start temperature 
(20oC) has been chosen. 
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In general when doing a temperature ramp, choose the SHU (T1...T4) sensor in the 
Select appropriate probe panel because one of these sensors can be placed in close 
proximity to the sample and will accurately report the sample temperature; only if the 
sensors T1 to T4 were absent would you need to specify the Temperature Controller 
sensor. When using one of the external sensors (T1…T4), tick Over-write temperature 
set-points with measured temperatures to record the temperature of the chosen probe 
(T1...T4) rather than that of the controller set-points.  
 
NB if you do use the temperature controller’s own sensor, be aware that it is likely that 
the temperature reported by the sensor will differ markedly from the actual sample 
temperature.  
 
Set up as described, the Chirascan would firstly go to the specified Start temperature 
and would then increase the temperature at the specified rate until it reached the Stop 
temperature. There are no pauses in the increase in temperature when used in this mode 
and measurements are made at the interval specified in Step. In the example, 
measurements (typically of circular dichroism at a single wavelength) would be made at 
20oC, 25oC, 30oC, 35oC and 40oC. In this example, the result would be a CD profile as a 
function of temperature for a specific wavelength. 
 
If you wish to carry out a temperature ramping experiment that pauses at specified 
temperatures, tick the Enable stepped ramping box in the Stepped temperature ramping 
panel. You will note that the Rate edit box in the Temperature range panel is greyed out 
when you select stepped ramping because in a stepped ramp experiment, the 
temperature controller will drive to the specified temperature as quickly as possible. In 
the dialogue box of the Stepped temperature ramping panel, type in the number of 
seconds you wish to allow for the sample itself to reach the specified temperature. In the 
above figure, it is set at 30s. A set up of this type would be used typically to measure a 
full CD spectrum at a series of temperatures. The resulting DataStore for the experiment 
would contain CD data as a function of both wavelength and temperature. 
 
N.B. there will inevitably be a lag between the temperature controller and the sample 
itself reaching a specified temperature. The lag will be dependent on the particular 
experimental conditions (e.g. sample volume, cell type, presence or absence of stirrer, 
etc.) and should be determined empirically before commencing the experiment. 
 
With Enable stepped ramping selected, Return ticket in the Temperature range panel 
and Take a final measurement in the End of ramp behaviour panel become active. 
Return ticket will step back through the temperatures to the start temperature, taking a 
measurement at each temperature; if you select Take a final measurement, then a 
measurement of whatever property you are studying will be taken at the Start, Stop or 
Specified temperature, depending on your selection. 
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3.8 The sample handling unit panel 
 
The Sample Handling Unit (ESHU) panel is shown below. It reports the temperature 
registered by the selected probe, allows you to input information about the sample and 
cell using Setup… and gives you access to the stirrer control and titration control 
dialogue boxes. 
 

 
 
The Sample Handling Unit (ESHU) panel provides feedback about temperature from 
one of four temperature probes (T1 to T4, from the drop-down menu); in the above 
figure, probe T1 is registering 24.9oC. The temperature measured by the chosen probe is 
one of the properties recorded in the DataStore. 
 
Click on the Setup… button to reveal the Sample and cell description dialogue box 
 

 
 
Use the dialogue boxes to enter a description of your sample and cell. The information 
is stored in the Datastore and can be viewed in either Pro-Data viewer (in the lower 
panel of the launchpad) or in the SCP (by clicking on the Setup… button). 
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3.8.1 Titration 
 
N.B. Prior to running a titration experiment, the software needs to know about the 
titration unit. Setting up the titrator is described in Section 3.11.12. Please refer to it 
before setting up any of titration protocols described below.  
 
If the titration accessory is present, the Titration button in the Sample Handling Unit 
panel will be active. Click on the Titration button to open the Titration window (see 
below). Click Enable Titration to activate the window and the unit. The titration 
accessory used with Chirascan is a Hamilton Microlab 541C dual syringe dispenser. It 
can be operated either in single-syringe mode, by choosing Single Syringe, which 
corresponds to a simple volume-targeted titration, or dual-syringe mode by choosing 
one of the two Dual Syringe options in the Protocol panel, corresponding to constant 
volume, concentration-targeted and volume-targeted titrations. 
 
Single Syringe mode is more likely to be employed with an external vessel and flow-cell 
set-up, where the experiment is not limited by the volume of an in-situ cuvette. The 
Dual Syringe options are more appropriate for working with an in-situ cuvette, where to 
avoid overflow, the volume that is added to the cuvette is compensated by an equal 
volume removed from it. 
 
Dual Syringe (Withdrawal / Addition of solution 1 to specified concentrations) allows 
you to specify the range and interval of concentration required. The program calculates 
the volumes of titrant that must be removed from and added to the sample to achieve the 
specified concentrations whilst maintaining a constant volume of liquid in the cuvette. 
 
Dual Syringe (Withdrawal / Addition of solution 1 by specified volumes) provides a 
completely flexible way of adding and removing volumes of titrant to and from the 
sample whilst maintaining a constant volume of liquid in the cuvette. 
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3.8.1.1 Single syringe, volume-targeted titration 

 

  
 
Click Single Syringe in the Protocol panel; go to the Cell / Cuvette Parameters panel 
and provide the requested information in the dialogue boxes. Providing this information 
accurately is essential to avoid spillages, especially if the titration is carried out in a 
fixed-volume cuvette inside the sample housing. Information relating to concentration is 
greyed out in single-syringe (volume-targeted) mode. 
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In the Syringe 1 (Solution 1) panel, enter a description of the solution in syringe 1 in the 
appropriate dialogue box. The Volume of Syringe 1 (ml) is specified in the Devices 
window, using the Titrator icon (see section on Devices) and in this case is 5ml. N.B. be 
sure that the actual and specified syringe volumes are identical. 
 
The Target Volumes/Concentrations panel is used to specify limits and steps in either 
volume or concentration, depending on the mode chosen. In Single Syringe (volume 
targeted) mode, the From edit box takes its value from the Initial volume of solution in 
cuvette (ml) edit box in the Cell / Cuvette Parameters panel, since the From volume 
cannot be less than the initial volume of solution in the cuvette. The To volume can be 
set at any value between the From volume and the volume of the cuvette or other vessel 
that is being used. If you accidentally type in a To volume that exceeds the volume 
specified in Cuvette capacity (ml), a warning will be given when you click on OK. You 
must specify a To volume that is less than the volume of the cuvette or vessel. In the 
Step edit box, you specify the incremental volume to be added before each measurement 
is made. Click on Generate list to create a list of volumes in the Volumes (ml) panel; in 
Single Syringe mode, the Concentrations (M) panel is inactive. Finally, note that the 
total volume of titrant (calculated from the Volumes list) is shown. If the volume 
calculated exceeds the volume of the syringe, then the software will assume that there is 
a reservoir from which to pick up more titrant via the switching valve of the titration 
unit. Use the calculated volume to ensure that you have enough titrant available. Click 
on OK when the titration is correctly set up. Note the panel will not close if you have 
failed to click on the Generate List button.  
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3.8.1.2 Dual syringe, concentration-targeted titration 
 

 
 
Select Dual Syringe (Withdrawal / Addition of solution 1 to specified concentrations) 
mode, go to the Cell / Cuvette panel and fill in the dialogue boxes. You will note that 
the Initial concentration of titrant in cuvette (M) is active (unlike Single Syringe mode) 
and you must specify the initial concentration of the titrant in the edit box. 
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In the Syringe 1 (Solution 1) panel, you can enter a description of the solution and must 
specify its concentration. The Volume of Syringe 1 (ml) is specified in the Devices panel 
using the Titrator icon (see Section 3.11.12), and in the above figure is 1ml. N.B. be 
sure that the actual and specified syringe volumes are identical. 
 
The Target Volumes/Concentrations panel is used to specify limits and steps in either 
volume or concentration, depending on the mode chosen; in this section we are dealing 
with concentrations. The From concentration is taken from the Initial concentration of 
titrant in cuvette (M) edit box. The To value can be set at any sensible value between the 
From concentration and zero, because with each addition of titrant an equal volume is 
removed from the cuvette and there is no danger of overflow. In Step, you specify the 
concentration steps that you wish to take over the range. With these parameters 
specified, you can click on Generate list, which will generate a list of concentrations in 
the Concentrations (M) box; click on the active left-arrow to generate the volumes in 
the Volume (ml) box and inspect both concentrations and volumes to be sure that you 
are getting what you want. Finally, note that the total volume of titrant (summed from 
the Volumes list) is calculated. If the volume calculated exceeds the volume of the 
syringe, then the software will assume that there is a reservoir from which to pick up 
more titrant via its switching valve. Use the calculated volume to ensure that you have 
enough titrant available. Click on OK when the titration is correctly set up. Note the 
panel will not close if you have failed to click on the Generate List button. 
 
Note that in this mode, the From, To and Step dialogue boxes are there simply to 
provide a convenient way of generating the Concentration (M) list when the step is 
constant. You can also type the desired concentrations, which do not necessarily have to 
be at constant interval, directly into the Concentration (M) list and by clicking on the 
active left arrow, generate the Volume (ml) list that corresponds to the concentrations 
you have specified. 
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3.8.1.3 Dual syringe, volume-targeted titration 
 

 
 
Select Dual Syringe (Withdrawal / Addition of solution 1 by specified volumes) mode, 
go to the Cell / Cuvette panel and fill in the dialogue boxes. You will note that the 
Initial concentration of titrant in cuvette (M) is active (unlike Single Syringe mode) and 
you must specify the initial molar concentration of the titrant in the edit box. 
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In the Syringe 1 (Solution 1) panel, you can enter a description of the solution and must 
specify its concentration. The Volume of Syringe 1 (ml) is specified in the Devices panel 
using the Titrator icon (see Section 3.11.12), and in the figure below is 5ml. N.B. be 
sure that the actual and specified syringe volumes are identical. 
 
The Target Volumes/Concentrations panel is used to specify limits and steps in either 
volume or concentration, depending on the mode chosen; in this section we are dealing 
with volumes. The From, To and Step dialogue boxes are greyed out because its use is 
inappropriate for this protocol and you specify the volumes that you want added / 
removed directly in the Volumes (ml) list. With the volumes specified, clicking on the 
active left arrow generates a list of corresponding concentrations in the Concentrations 
(M) box. Finally, note that the total volume of titrant (summed from the Volumes list) is 
calculated. If the volume calculated exceeds the volume of the syringe, then the 
software will assume that there is a reservoir from which to pick up more titrant via its 
switching valve. Use the calculated volume to ensure that you have enough titrant 
available. Click on OK when the titration is correctly set up.  
 
3.8.2 Stirrer 
 

 
 
If the stirrer module is installed, the Stirrer button on the Sample Handling Unit 
(ESHU) panel will be active. Click on Stirrer to reveal the Stirrer Control window 
shown above. Use the slider bar to vary the rate of stirrer rotation: the stirrer will rotate 
at the chosen speed until it is switched off unless it is being used in conjunction with a 
titration experiment. When running a titration, the Stirring time (s) specifies the time in 
seconds that the stirrer should run after the addition of an aliquot and the Settling time 
(s) specifies how long the sample should stand after stirring and before measurement. 
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3.9 Toolbar icons 
 

 
 
Positioning the cursor over the icon will call up a brief description of it; a somewhat 
fuller description is also provided in the status bar at the foot of the interface. 
 

  Open the APL-supplied examples folder. 
 

x This will open a folder in which there are several examples of spectra 
supplied by APL that can be used as templates to set up the Pro-Data 
interface or to familiarise oneself with the use of Pro-Data viewer. 

  

  Open a previously collected data file. 
 

x This will open a window showing the contents of the currently active 
directory or the examples folder if you have just launched Pro-Data. 
Opening a data file from this window will configure the interface with the 
experimental parameters contained in that file. 

 

  Save the active document. 
 

x If there is new data that needs saving, this icon will open a Save As 
window showing the currently active directory. If there is no new data, an 
information window saying so will appear.  
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  Call up Seed Names window. 
 

x A shortcut to the Seed Names window, where you can specify seed names 
for spectra and baselines. In a series of experiments, the file names will 
share the chosen seed name and be differentiated by an automatically 
incrementing numeric component, e.g. Protein0001, Protein0002… 

 

  Call up Remarks window. 
 

x This opens a window in which you can record information about your 
experiments. The remarks are stored in the Datastore and can be viewed 
in Pro-Data viewer (in the lower panel of the launchpad). 

 

  Set personal preferences. 
 

x This icon opens a window where you can set personal preferences, e.g. 
measure CD in millidegrees rather than delta A. 

 

  Launch Pro-Data viewer. 
 

x Pro-Data viewer will appear on your screen. It will be open at the default 
working directory, from where you can navigate in the usual way.  

 

  Call up About Chirascan window. 
 

x A window will open giving the version number of the Chirascan software. 
 

  Launch Help. 
 

x Click on the Help icon to launch the context sensitive help program. 
Move the cursor / question mark to the item about which you want to 
know and click on it. 
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3.10 Drop-down menus 
 
Much of what is available in the drop-down menus is more readily accessible from the 
icons in the toolbar. A full list of the functionality is given below; inevitably, there is 
some repetition of the information in section 3.9 Toolbar Icons. 
 
3.10.1 The File menu 
 

 
 
The File menu presents the usual options and shortcuts for opening and closing files. It 
is unlikely that you will need to use these, because their functionality is more 
conveniently accessible elsewhere in Pro-Data and in Pro-Data viewer. The examples 
folder can be accessed from this menu, in which there are several examples of spectra 
supplied by APL that can be used as templates to set up Pro-Data or as tools to 
familiarise oneself with the use of Pro-Data viewer. 
 
3.10.2 The View menu 
 

 
 
The View menu offers six options. 
 

x Chirascan viewer: The Pro-Data viewer launchpad will appear on your 
screen. Pro-Data viewer is described in detail in a manual of its own. 
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x Devices…: The Devices window will appear on your screen. It contains a 

number of icons corresponding to hardware devices that may need to have 
certain parameters adjusted. See Section 3.11 for a detailed description of 
the Devices panel.  

 
x Remarks…: This opens a window in which you can record information 

about your experiments. The remarks are stored in the Datastore and can 
be viewed in either Pro-Data viewer (in the lower panel of the launchpad) 
or in Pro-Data (by clicking on the Remarks icon). Information can be 
copied and pasted using the usual select, copy (Ctrl+C) and paste 
(Ctrl+V) functions if required. 

 
x Toolbar: a toggle to display or hide the toolbar. 

 
x Always on top: a toggle to force Pro-Data to be the top window. 

 
x Preferences…: This opens a window where you can set personal 

preferences, e.g. measure CD in millidegrees rather than delta A, record 
absorbance rather than transmission, etc. A full description is given in 
Section 3.13. 

 
3.10.3 The Help menu 

 

 
 
The Help menu presents two items: 
 

x Help Topics: This launches the help manual. You can browse the contents 
and search for specific words and phrases. 

 
x About Chirascan… Opens a window giving the version number of the 

Chirascan software. 
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3.11 The devices window 
 
N.B. The following refers to software functionality intended for experienced users only. 
Changing device parameters without a thorough knowledge of what they control may 
lead to undesirable consequences. Take care! 
 

 
 
Select Devices… from the View drop-down menu to reveal the Devices Window.  
Clicking on any of the icons shown will display a further window associated with the 
device, except for the cases where access to the device window is password-protected. 
Access to some devices is denied for all but trained personnel. 
 
System Reset will reset any user-adjustable parameters accessible through the Devices 
panel to their factory defaults. It is unlikely that you would need to do this. 
 
Calibrate Zero Offsets will adjust the electronic offset to take into account any small 
drift that may have occurred over time. It is unlikely that you will need to this on a 
regular basis. The offsets should not be changed until the instrument electronics are at 
their normal working temperature (it is good practice to leave the electronics switched 
on at all times) nor should they be changed part-way through a series of experiments, 
since recalibrating the offsets may shift the CD baseline slightly. 
 
Service Password… opens a dialogue box that permits you to changer the password that 
gives access to the advanced sections of the Devices panels. If you change it, do not 
forget it because APL engineers will not be able to rediscover it for you. 
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3.11.1 The monochromator  
 

 
 
Clicking on the Mono icon will display the Monochromator window. 
 

 
 
In the Wavelength (nm) panel, you can use the slider bar or the edit box to specify a 
wavelength; clicking the Set button will drive the monochromator to the chosen 
wavelength. Likewise, use the Bandwidth (nm) panel to set the bandwidth. These 
settings are the ones to which the monochromator will drive when the software is 
started. The Status panel reports what the monochromator is doing – when it is 
executing your instruction, the status reported would be Updating and No respectively 
in the Current action and Reached target boxes and on completion the text would read 
Ready and Yes, as shown above. The temperature of the mono block is recorded and can 
be refreshed using the button adjacent to the reported temperature. Reset causes the 
mono to verify its limits, both in wavelength and bandwidth; Park mono puts it into a 
safe position, ready for transportation. When you are happy that the parameters are 
correctly set, click on OK; to close the panel without implementing the changes, click 
on Cancel.  
 
The Calibration File panel should be used only under instruction from an APL technical 
support person.  
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3.11.2 The emission monochromator 
 

 
 
Click on the EmMono icon to display the Emission Monochromator window. 
 

 
 
If the emission monochromator were installed, the Status panel would read Ready and 
Yes in Current action and Reached target respectively. From this panel, you can use the 
slider bar or adjacent edit box to specify a wavelength; clicking Set will drive the 
monochromator to that wavelength. 
 
If the emission monochromator is not installed or is incorrectly installed, clicking the 
EmMono icon will prompt the display of the following warning window. 
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3.11.3 The attenuator 
 

 
 
Clicking on the Attenuator icon will display the Attenuator / Shutter Control window. 
 

 
 
The attenuator operates both as attenuator and shutter. The Open and Close buttons 
mimic those found in the Pro-Data interface and are linked to them – changes in one set 
are replicated in the other. The maximum opening can be limited using the slider bar 
and this may be appropriate in special circumstances (for example to protect reduce 
damage to samples) but in general the attenuator should not be limited in its maximum 
aperture. The status of the aperture is shown on the Current attenuator position slider; if 
the maximum aperture were limited, then that would also be shown in the slider 
position. The shutter display on the interface is linked to this function and therefore the 
status of the attenuator can be ascertained from the interface too. 



 

 3.38 Updated February 2007 

 
3.11.4 The photo-elastic modulator (PEM) 
 

 
 
Clicking on the PEM icon will display the PEM window. 
 

 
 
There are no parameters that can be changed by the user. The Amplitude (volts) panel is 
passive – if it were viewed during a CD scan, you would see the voltage slowly 
changing as the scan progressed. The PEM Status panel simply reports on the health of 
the photo-elastic modulator. Note that the PEM Test box gives the result of a self-test 
carried out by the PEM electronics and would normally read Passed.  
 
LAAPD bias mode anticipates the introduction of a new accessory and is not yet 
implemented. 
 
Clicking on the Advanced… button will cause a password prompt to appear. On typing 
in the correct password, the user is given access to parameters that can be changed. 
However, none of the parameters in the PEM Advanced… panel should be changed by a 
user unless under instruction from a qualified engineer. 



 

 3.39 Updated February 2007 

 
3.11.5 Auxiliary detectors 1 and 2 
 

 
 
If detectors are installed (e.g. a dedicated absorbance detector), clicking on the Aux1 or 
Aux2 icon will prompt the display of a PMT control panel.  
 

 
 

The PMT HV slider allows you to choose an arbitrary detector HV between 0V and 
1000V; the ZeroHV button will set the voltage to 0V; the AutoPM button will adjust the 
detector HV so that the photomultiplier anode current resulting from the intensity seen 
by the detector is at the optimum level for the Chirascan electronics. Click on the Apply 
button to apply the HV to the detector. 
 
If detectors are not installed, an information window will appear.  
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3.11.6 The fluorescence detector 
 

 
 
In standard configuration, the fluorescence detector is not present and clicking on the 
Fluorescence icon will prompt the display of the information window below. 
 

 
 
If the fluorescence channel is installed, clicking on the Fluorescence icon will display 
the Fluorescence Photometric Channel window. 
 

 
 
The Fluorescence Photometric Channel permits you to apply voltages to the 
fluorescence detector, which govern its gain. The PMT HV slider allows you to choose 
an arbitrary detector HV between 0V and 1000V; the ZeroHV button will set the voltage 
to 0V; the AutoPM button will adjust the detector HV so that the photomultiplier anode 
current resulting from the fluorescence intensity seen by the detector is at the optimum 
level for the Chirascan electronics. Usually, AutoPM would be used when the maximum 



 

 3.41 Updated February 2007 

 
fluorescence intensity from the sample is striking the detector. Click on the Apply 
button to apply the HV to the detector. It will remain at this level throughout a 
subsequent fluorescence scan. 
 
Clicking on the Advanced… button will cause a password prompt to appear. On typing 
in the correct password, the user is given access to parameters that can be changed. 
However, none of the parameters in the fluorescence Advanced… panel should be 
changed by a user unless under instruction from a qualified engineer. 
 
3.11.7 The circular dichroism DC channel 
 

 
 
Click on the CDDC icon to display the CD DC Photometric Channel window. 
 

 
 
Chirascan is a CD spectrometer and therefore this channel (and the CD AC channel) 
will always be active. The CD DC Photometric Channel permits you to apply voltages 
to the CD detector, which govern its gain. The PMT HV slider allows you to choose an 
arbitrary detector HV between 0V and 1000V; the ZeroHV button will set the voltage to 
0V; the AutoPM button will adjust the detector HV so that the photomultiplier anode 
current resulting from the intensity seen by the detector is at the optimum level for the 
Chirascan electronics. Click on the Apply button to apply the HV to the detector. 
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In a CD scan, the detector HV (and so its gain) is adjusted so that at every point in the 
spectrum, the anode current is at its optimum level for the Chirascan electronics. If this 
window were open during a CD scan, the PMT HV slider and the associated edit box 
would show HVs that changed as the scan progressed, being high where the sample 
absorbance is high and low where the absorbance is low. 
 
Clicking on the Advanced… button will cause a password prompt to appear. On typing 
in the correct password, the user is given access to parameters that can be changed. 
However, none of the parameters in the CD DC Advanced… panel should be changed 
by a user unless under instruction from a qualified engineer. 
 
3.11.8 The circular dichroism AC channel 
 

 
 
Click on the CDAC icon to display the CD AC Photometric Channel window. 
 

 
 
There is nothing in this panel that is active except for the Advanced… and Close 
buttons. Clicking on the Advanced… button will cause a password prompt to appear. On 
typing in the correct password, the user is given access to parameters that can be 
changed. However, none of the parameters in the CD AC Advanced… panel should be 
changed by a user unless under instruction from a qualified engineer. 



 

 3.43 Updated February 2007 

 
3.11.9 The kinetic sample-handling unit (KSHU) 
 

 
 
The KSHU is in the devices panel because the software for the Chirascan is common 
with APL stopped-flow products. Clicking on the KSHU icon will cause a password 
prompt to appear. On typing in the correct password, the user is given access to 
parameters that can be changed. However, none of the parameters in the KSHU panel 
should be changed by a user unless under instruction from a qualified engineer. 
 
3.11.10 The motors 
 

 
 
Clicking on any of the Motor icons will cause a password prompt to appear. There are 
no parameters in any of these devices that should be changed by a user.  
 
3.11.11 The electronics 
 

 
 
Clicking on the Electronics icon will cause a password prompt to appear. There are no 
parameters in the electronics that should be changed by a user. 
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3.11.12 The titrator - syringe configuration 
 

 
 
Click on the Titrator icon to display the Titrator – Syringe Configuration window. 
 

 
 
The titration accessory used with Chirascan is a Hamilton Microlab 541C dual syringe 
dispenser which can be operated in single-syringe or dual-syringe mode. Since the 
physical configuration can vary – e.g. syringe sizes may be different for different 
applications – it is essential to set up the Titrator – Syringe Configuration window to 
reflect the real set up. You will also need to prime the unit using the Control panel. 
There are two syringes – choose No.1 from the drop down menu adjacent to Syringe 
Number. All subsequent input and control, including changes in the Advanced… 
settings, will apply to syringe No.1 uniquely. 
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In the Setup panel, select the Syringe Volume (ml) from the drop-down menu and be 
sure you select the same volume as that of the installed syringe. Clicking on the 
Advanced… button will cause a password prompt to appear. It is unlikely that you will 
need to change the parameters in the Advanced Settings – they govern syringe speed, 
backlash correction and resolution – but if you do, you will need to contact APL 
technical support for the service password and advice. Click the Save button to save the 
No.1 syringe information. 
 
The Control panel enables you to prime the titration unit. The buttons Pickup, Dispense 
and Absolute do not operate the valve, that is they simply pick up and dispense through 
the same tube. You can control which tube this is by choosing In, Out or Wash from the 
Valve drop-down menu; because the aforementioned buttons do not exert control over 
the valve, the Auto option is redundant. Use the Volume (ml) edit box to specify the 
volume that you wish to move, choose the valve position that you wish to use and click 
on Pickup to draw the specified volume into the syringe, Dispense to expel the specified 
volume from the syringe and Absolute to move the syringe to the absolute position 
corresponding to the specified volume. 
 
The Add and Remove buttons should be used with the Auto option from the Valve drop-
down menu. Add and Remove do exert control over the valve and will use this control to 
replenish the syringe if it is requested to deliver or remove a larger volume than is 
available in the syringe. For example, a 5ml syringe may have 1ml of solution 
remaining in it when an Add 2ml request is made. The computer instructs the ML500 to 
switch the valve to the reservoir (or other source vessel) and draw in 4ml of solution 
from it to fill the syringe prior to switching the valve back to the cuvette (or other target 
vessel) and dispensing 2ml of solution. Likewise, a request to Remove 2ml from a 
vessel when there is less than 2ml volume remaining in the syringe would prompt a 
sequence of actions that would first empty the syringe to a waste (or other target) vessel 
prior to drawing 2ml from the cuvette (or other source vessel). 
 
Syringe No.2 is set up in a similar fashion by selecting No.2 from the Syringe Number 
drop-down menu. 
 
The Status panel reflects the commands given in the Control panel in real time. The 
schematic diagram of the front of the ML500 is labeled to reflect the convention used 
by Hamilton in the ML500 manual, as is the button nomenclature in the Control panel. 
 
Finally, you can reset the syringe to its zero position by clicking on Reset. 



 

 3.46 Updated February 2007 

 
3.11.13 The circulator 
 

 
 
Click on the Circulator icon to display the Circulator or Peltier Temperature Control 
Unit window. 
 

 
 
The drop-down menu at top left presents you with the currently supported temperature 
control devices, which are the Neslab RTE-111, RTE-200, Fisher 3016, the Melcor 
MTCA Peltier, the Quantum Northwest Peltier and the TCM-series peltier. Choose one 
of these and click on Connect. You can choose to set the selected device to be the 
default. 
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The second drop-down menu allows you to specify the serial port number to which the 
device controller is connected. Typically it would be COM1 but if another serial device 
is installed on COM1, it will be one of the others.  
 
In the Control probe panel, choose between the internal temperature probe of the device 
(recommended for all and the only option for the Melcor). However, if you wish to 
substitute an external probe, for all supported temperature controllers except the Melcor, 
you are able to do so. 
 
3.11.14 The 4 cell auto-changer 
 

 
 
Click on the QNW icon to display a window for controlling the Quantum North-West 4-
cell auto-changer, if it is installed.  
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3.12 The preferences panel 
 
Clicking on the Preferences icon or selecting Preferences… from the View drop-down 
menu (short-cut Ctrl+K) will display the Preferences window. 
 

 
 
The panel opens at the Viewer tab and here you can control how the Pro-Data Viewer 
looks when launched (with or without the blank display) and whether or not the display 
automatically rescales when a data point is measured that is outside the limits of the 
currently-displayed y-axis. 
 

 
 
Under the CD tab, in the Default Mode panel, select either delta A (delta absorbance) or 
millidegrees as the units for expressing circular dichroism; in the Auxiliary 
Measurements panel, HT is greyed out and permanently selected (i.e. the detector HT 
will always be recorded in CD mode) but there is a choice about whether or not you 
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record Temperature; and in the AutoAbsorbance panel, you can choose to Enable 
AutoAbsorbance by default, which is recommended. 
 

 
 
Under the Absorbance tab, you can set your preferences for absorbance measurements 
and optionally record temperature as an auxiliary measurement. In the Default Options 
panel, you can select to measure spectra at constant detector high-voltage (AutoPM not 
selected) or at a voltage that is automatically optimized at each point in the spectrum 
(AutoPM selected). Arguably, the constant voltage will give the more accurate 
absorbance measurement because there is no risk of hysteresis associated with sharp 
changes in the detector high-voltage but you must be careful to ensure that the detector 
is not saturated during the measurement. Selecting AutoPM will obviate that possibility 
and because there are unlikely to be big changes in HV from one point to the next, using 
AutoPM will not degrade the absorbance measurement in any significant way.  It is 
recommended to leave this option selected. 
 
The Fluorescence tab allows you to record Temperature and detector HV as auxiliary 
measurements – these are selected as default. 
 
The Seed names window enables you to specify seed names for spectra and baselines. In 
a series of experiments, the file names will share the chosen seed name and be 
differentiated by an automatically incrementing numeric component, e.g. Protein0001, 
Protein0002… This panel can be accessed directly using the Seed names icon in the 
toolbar. 
 
The Startup preferences window allows you to start the SCP in Spectrum, Kinetic or 
Spectra-kinetic modes. For Chirascan, the default Spectrum is usual. You can also 
choose to start the software in emulator mode, i.e. in the absence of any hardware, but 
that is unlikely to be of interest during normal use. 
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Appendix 1: Continuous temperature ramp with data 
sampling at discrete intervals 
 
A basic description of the use of the software is given in section 3.8 of the Chirascan 
manual. Some hints and tips to get good data are given below – please read the whole 
document, referring to the manual where appropriate, before commencing your 
experiment. 
 
Setting up the temperature control unit 
 
It is assumed that the peltier control unit is correctly installed and switched on. The 
Settings button in the Temperature control unit panel of the Chirascan user interface 
should be active; if it is greyed out, close down and restart the Chirascan software. 
 
The parameters over which you have control are the start temperature, stop temperature, 
temperature interval, rate of temperature change, tolerance within which the 
measurement will occur, the measuring time per point and of course the wavelength. 
Click on the Settings button to call up the following window: 
 

 



 

 3.51 Updated February 2007 

 
Select Enable ramping. In the Temperature range panel, type in the desired Start, Stop, 
Step, Rate and Tolerance parameters. In the End-of-ramp behaviour panel, select an 
appropriate option. In the example, the temperature will go to 20oC at the end of the 
experiment. In Temperature sensor, choose SHU. 
 
Unless your sample is sensitive to light at the wavelength at which the experiment is to 
be conducted, the best results will be obtained by collecting data for as much of the 
ramp time as possible and by recording a sufficient number of points to define the 
change that occurs.  The maximum possible measuring time would be defined by setting 
the tolerance to be exactly half the step and then setting a time per point (in the 
Sampling panel of the Chirascan user interface) equal to the time it takes to cover the 
step at the specified ramp rate. In an ideal world, that would give you 100% efficiency. 
However, there is an assumption here about the constancy of the ramp rate and there is 
also a small amount of instrument dead time associated with writing data to disk, so 
running at about 80% efficiency is the maximum recommended. An example of an 80% 
efficient profile is given in below. 
 

T range Start Stop Step Rate Tolerance 

Specified 
measuring 
time per 
point 

Measuring 
time during 
46 min ramp 

4oC-96oC 4oC 96oC 0.5oC 2 oC/min 0.2oC 12 s ~37 min 
 
With these parameters, the measurement would start 0.2oC before each data point (0.5oC 
interval) and continue for 12 seconds. The ramp rate is 2oC per minute and therefore the 
measurement would occur over a range of 12/60 of 2oC, i.e. 0.4oC. Thus the 
measurement would be symmetrical about each target temperature and data would be 
recorded for 80% of the time.
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Setting up the monochromator for a single wavelength 
 
Click on the Adv… button in the Monochromator panel of the Chirascan user interface 
to bring up the following window: 
 

 
 
Select Single wavelength and type in the wavelength of interest in the dialogue box. 
Click on OK to return to the Chirascan interface. 
 

 
 
In the Monochromator panel, Wavelength (nm) is the monochromator rest wavelength 
to which it returns at the end of each measurement and to save unnecessary wavelength 
change, it should be set to the wavelength chosen for the temperature ramp. Set the 
Bandwidth (nm) box to a suitable value – 1nm is in general perfectly good. 
 

 
 
In the Sampling panel, set the Time-per-point (s) to the value calculated from the 
following equation: 
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Time per point = (2*tolerance/rate)*60 seconds. 

 
For the example given here, tolerance is 0.2oC, rate is 2oC per minute and the time per 
point is therefore 12 seconds. The reason for calculating it thus is to ensure that the data 
for each point is collected symmetrically, in this case +/- 0.2oC. 
 
It is also important to remember that the peltier device has ramp-rate controlling 
parameters (the so-called proportional, integral and differential or PID parameters, 
which are not user adjustable) so that the ramp-rate changes as it approaches its target 
final temperature in order not to overshoot the target by too much. This is perfect for 
stepped-ramping, where you want to equilibrate quickly at a given temperature before 
measuring a spectrum but less than ideal for a continuous ramp at a single wavelength. 
It should be remembered too that the sample temperature will lag behind the peltier 
temperature and for these reasons it is recommended that the temperature range be set at 
the range of interest minus 5oC at the lower end and plus 5oC at the upper end. In the 
above example, the range of interest should be included within the range 9oC<T<91oC. 
Measurements will occur over the whole specified range but the range can subsequently 
be clipped for analytical and display purposes. 
 
Ensure your sample is in place, that the temperature probe is inserted and not blocking 
the light path and then click on Start. The program will execute your instructions. You 
should see your peltier drive to the start temperature, stabilise and then begin a smooth 
temperature ramp, recording data at the specified interval for the specified time, 
stopping only when it gets to its final temperature, after which it will go to the specified 
end-of-ramp temperature. 
 
The program uses the peltier block temperature to trigger its data collection but records 
the actual sample temperature with the data. At the end of the experiment, the graph is 
redrawn with CD as a function of the actual sample temperature. 
 
Important note (1). If you wish to record absorbance simultaneously with CD, you will 
need to take a single reference point against which absorbance can be measured. To do 
this, go to the Temperature control>Settings window and deselect (uncheck) Enable 
temperature ramping. Close the window and without your sample in the light path, click 
on Baseline in the Chirascan user interface. Then reselect Enable temperature ramping. 
 
Important note (2). Before launching your temperature ramp experiment, check that 
there is a meaningful level of light getting through your sample and reaching the 
detector, especially if you are working in the far UV. To check light levels, put your 
sample in the light path and go to Configuration>Devices>CDDC. Ensure that the 
monochromator is set at the correct wavelength and then Open the shutter. Click on  
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AutoPM a couple of times in the Devices panel and read the detector HT. Be certain that 
it is in the range 200V<HT<600V, preferably towards the lower end of this range if 
possible. 
 
Important note (3). Be sure you are measuring at a suitable wavelength. Protein 
secondary structure does change with temperature but such change does not always 
result in a change in CD signal at all wavelengths. Ensure that you have chosen one 
where change in CD signal occurs. Of course, this implies knowledge of the behaviour 
of your sample and it might not always be possible to know in advance how the CD will 
change. 
 
Important note (4). Your sample will evaporate when it is heated! Seal the cell if 
possible to reduce the risk of evaporation and the problems it will bring! 
 

 
Lysozyme denaturation 
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Stepped temperature ramp with measurement of spectrum at 
specified temperatures 
 
Many of the considerations outlined in the above section do not apply to stepped-
ramping because the temperature is held at a specified temperature for the duration of 
the measurement. Typically, stepped-ramping is used if you wish to measure full spectra 
at specified temperatures. The process is outlined in section 3.8 of the Chirascan 
manual. 
 
The Settling time in the temperature control panel should be set to allow the sample time 
to equilibrate. The sample temperature will never exactly match the block temperature 
but will stabilise at a somewhat lower temperature. An appropriate settling time for a 
given cell (e.g. 1mm pathlength) can be established by doing a dummy run with water. 
Whilst this will take some time, it need be done only once for a given cell type and will 
also show any experimental shortcomings before precious sample, which may be 
irreversibly damaged by heat, is committed. The figure below was generated using a 
1mm pathlength cell and a 120 second settling time. 
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The measurement was made from high to low wavelength and took about 3 minutes to 
complete. As can be seen, the temperature did increase gradually during the  
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measurement but by only 0.2oC and that is unlikely to cause problems. Allowing the 
sample to equilibrate for longer would reduce the temperature rise during the 
measurement but it would of course take longer to complete the experiment. 
 
The experimental parameters in both continuous and stepped-ramping will always be 
constrained by practical considerations – how long you wish to spend on the 
experiment, whether the process is monophasic or biphasic, how big is the signal 
change, how rapid is the change from state A to state B or B to C, is the sample 
photosensitive and so on. Some of these considerations will be conflicting and it may 
require some exploratory work before the ideal set of parameters is found. 
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Appendix 2: Baseline subtraction 
 
Residual birefringence in the photocathode of the PMT and in the cuvette means that a 
non-zero CD baseline will exist and that it will add its contribution to that of the sample. 
The systematic error introduced by residual birefringence in the system can be 
legitimately corrected by measuring it using a blank and then subtracting the baseline 
from the gross CD spectrum of residual birefringence plus sample. The true CD 
spectrum of the sample will be revealed.  
 
However, random noise exists on any measured baseline or spectrum and such random 
noise can create problems for the unwary. If a baseline is measured and then subtracted 
from a series of spectra which are subsequently averaged, the noise in the result will be 
overly influenced by the noise in the baseline. Consider: 
 
Gx1 – y 
Gx2 – y 
Gx3 – y 
Gx4 – y 
. 
. 
. 
GxN – y 
 
where Gxi represents the random noise deviation from the underlying spectrum and y 
represents the random deviation from a single baseline. Taking the average of the 
deviations: 
 
      N                              N 
1 {6Gxi – Ny} =   1 6Gxi – y 
N   i=1                        N i=1 
 
As N tends to infinity, 6Gxi tends to zero and the noise in the baseline-subtracted, 
averaged spectrum becomes the noise in the baseline itself. Of course, if a separate 
baseline were to be measured for every spectrum, this problem would not occur.  
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There are approximately 400 spectra of lysozyme in the above figure – the experiment 
was to monitor the photolysis of the protein over time. Each spectrum was measured in 
about 90 seconds. The secondary structure changes with time and it is therefore not 
appropriate to average the spectra but we are interested only in the random noise on the 
spectra. Noise can be separated from a spectrum by smoothing the spectrum and 
keeping the residual (Obs – Calc). Taking the average of the residuals is a valid 
operation and shows that the random noise is dramatically reduced by the process of 
averaging (theory tells us that a 20-fold improvement in S/N would be expected from 
averaging 400 observations). 

            
Residuals (Obs-calc) shown left and their average shown right 
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Repeating the above process with a single baseline subtracted from each spectrum prior 
to generating the residuals yields a quite different picture. The average residual (noise) 
is, to all intents and purposes, identical to the single baseline residual. 

        
Single-baseline-corrected residuals shown left and their average shown right 

 
The improvement in S/N inherent in averaging is lost and worse, any artefact in the 
baseline would be reinforced in just the same way as the random noise is and there is 
thus a danger that any such ‘feature’ could be misinterpreted as real. 
 
In order to avoid the impractical and tedious business of measuring a separate baseline 
for every spectrum, smoothing the baseline prior to subtracting it from a series of 
spectra will eliminate the problem. A baseline should not have any ‘sharp’ features in it 
and can therefore be smoothed considerably without introducing any artefacts; if it does 
have features, it is likely that the cell was not cleaned properly or some other artefact 
has crept in to the measurement and it should be discarded and measured again. 
 
Repeating the above procedure with a single, smoothed baseline subtracted from the 
spectra prior to calculating the residuals takes us back to the correct result. 

            
Single, smoothed-baseline-corrected residuals shown left and their average shown right 
 
 



 

 3.60 Updated February 2007 

 
Appendix 3: Using CDNN to calculate the secondary 
structure of proteins. 
 
Attention 
 
CDNN is a third-party program that is included as a courtesy on the installation disk, 
with the permission of its author, to assist users in calculating protein secondary 
structures. Any publication of results calculated using CDNN should refer to the author 
(see CDNN manual on disk for details). 
 
Installing CDNN on your computer 
 
Insert the Applied Photophysics Chirascan installation disk, click on CDNN and follow 
the instructions for installation. The program, unless otherwise specified during 
installation, will reside in C:\program files\CD deconvolution\ and a short-cut will 
appear that can be dragged onto the desktop. 
 
Using CDNN 
 
Double-click on the desktop icon to launch the program. 
 

 
 
Click on File>Open… On first use, the program will open at the Sample Files folder 
(C:\program files\CD deconvolution\sample files\). 
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Select one of the sample files and click on Open. (NB the above illustration contains 
additional files that are not part of the original set.) The following dialogue appears: 
 

 
 
All the examples in the Sample Files folder are converted to Delta Epsilon, the 
differential extinction coefficient (in this case further normalised for the number of 
amino acid residues, of which more later). Click on OK. The panel will disappear and 
you will be left with the start-up panel. Click on Deconvolute to calculate the 
contributions of the various components to the protein secondary structure. 
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The example given here is that of lysozyme (Sample Files>Lysozym.txt). The units, 
delta epsilon, are per amino acid residue. Once you are familiar with the use of the 
program and what the results mean (it is recommended that you read the notes that 
come with the program itself), move on to your own samples. 
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Using CDNN with your own results 
 
Measure the CD spectrum of your protein and carry out any manipulations, such as 
averaging, baseline correction and smoothing. Note that baseline correction is essential 
to get reasonable results. 
 

 
Lysozyme and baseline spectra, several repeat measurements 

 
 

Concentration 0.2mg/ml 

Path length 0.5mm 

Molecular weight 14600 daltons 

No. of amino acids 129 

Bandwidth  1nm 

Wavelength range 180nm – 260nm 

Step-size 0.5nm 

Conditions of measurements 
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Lysozyme spectrum, after averaging, baseline correction and smoothing 

 
CDNN requires a text-file input format, with wavelengths and associated CD values at 
1nm intervals. It does not matter if you have measured the spectrum at a different step-
size (the above spectra were measured at 0.5nm steps) because there is a conversion 
program that generates the correct input format. Click on File>Save current plot… to 
call up the following window and choose CDNN files (*.txt) from the drop-down list 
under Save as type. Specify a filename and location and click on Save. 
 

 
 
Launch CDNN as previously described and open the file that you have just saved. This 
example uses the lysozyme data described above. Note that, unlike the examples in 
Sample Files folder, these CD data are in millidegrees. Care is needed to ensure that the 
results are meaningful. 
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With the Millidegrees radio button selected, the Essential Parameter dialogue box 
appears. It is imperative that the information requested be supplied. For lysozyme 
measured under the conditions given above, the fields are correctly filled in. Click on 
OK and then Deconvolute. 
 

 
 
Comparison of the example and real data will show that the results are broadly similar. 
There are small differences in the spectra and it is not therefore surprising that there are 
small differences in the calculated contributions of the various secondary structure 
components. 
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Dealing with uncharacterised proteins 
 
Not all proteins are well characterised and for example, the molecular weight may not 
be known. Fortunately that does not prevent you calculating the secondary structure 
components. In brief it is sufficient to replace the molecular weight of the protein with 
the average molecular weight of the amino acid residues (generally accepted to be about 
113) and to replace the actual number of amino acids with the number 1. 
 

 
 
Click on OK and Deconvolute to generate an identical result to that using the correct 
molecular weight and the correct number of amino acid residues. 
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Normalising for concentration and number of amino acid residues 
in an unknown protein 
 
Concentration, generally expressed in mg/ml for proteins, is numerically equivalent to 
concentration in g/l. The molarity of the solution is therefore concentration in mg/ml 
divided by the MW of the protein. 
 

Molarity = conc (mg/ml)/MW 
 
A commonly accepted value for the MW of an amino acid residue is 113. The number 
of residues in a protein is therefore its molecular weight divided by 113. 
 

Number of amino acid residues = MW/113 = N 
 
If your protein is not fully characterised, then the MW is unknown. However, that does 
not stop you from normalising for both concentration and the number of amino acid 
residues. 
 

Measured CD normalised for concentration = (Measured CD)/Molarity 
 

Measured CD normalised for number of residues = (Measured CD)/N 
 

Measured CD normalised for concentration and number of residues = 
 

(Measured CD)*(1/Molarity)*(1/N) 
 

= (Measured CD)*(MW/mg)*(mean residue MW/MW) 
 

= Measured CD*(113/mg) 
 

You can see that the calculation does not require knowledge of the MW of the protein 
nor its molar concentration. All that remains to be done is to normalise for pathlength – 
NB in centimetres.  
 
If you know your protein, then converting to molar delta A ('H) or molar delta 
ellipticity ('4) in the Pro-Data (Chirascan) program would be the normal route, prior to 
going in to CDNN. If you wish to normalise for the number of residues as well, which is 
what is usually done, then the number of amino acid residues can be calculated by 
dividing the true MW by 113 and this number should be input to the CDNN program in 
the appropriate field. 
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Transferring CDNN results to Excel 
 
Because of its quirky nature, CDNN print functions do not work correctly and once the 
secondary structure calculation is done, you may wish to copy data to another program. 
We recommend that Excel be used as the recipient program. Use the Edit>Copy Table 
and Edit>Copy Graph commands in the Deconvolution window to copy the results and 
the graph respectively and then paste them into Excel. 
 
Final note 
 
CDNN is not the only program that estimates component contributions to protein 
secondary structure. There are others, some of which can be found via these links 
 
K2D:  http://www.embl-heidelberg.de/~andrade/k2d
 
Dichroweb: http://www.cryst.bbk.ac.uk/cdweb/html/

 
Dichroprot: http://dicroprot-pbil.ibcp.fr/

 
CDPro:  http://lamar.colostate.edu/~sreeram/CDPro/

 
Be aware that all secondary structure calculations are notoriously ‘soft’ (because the 
calculations are under-determined) and results will depend on the basis sets chosen as 
well as the quality and extent of the data. 

http://www.embl-heidelberg.de/%7Eandrade/k2d
http://www.cryst.bbk.ac.uk/cdweb/html/
http://lamar.colostate.edu/%7Esreeram/CDPro/
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Appendix 4: Recalibrating the Chirascan 
 
Recalibrating CD 
 
NB You will need system administrator privileges to change the CD calibration. 
 
Camphorsulphonic acid (CSA) is widely used for the calibration of CD instruments. 
Some care does need to be taken in its preparation in order that it can be used for 
calibration purposes because CSA is hygroscopic and that makes it difficult to weigh 
accurately. However, CSA has been studied in depth and it is known to have an 
ellipticity of 335 millidegrees when a solution of precisely 1mg/ml is measured in a 
10mm pathlength cuvette. It is known from the literature that the extinction coefficient 
of anhydrous CSA is 34.5 at its absorption maximum (285nm) and this means that the 
concentration of a solution made up at approximately 1mg/ml can be determined 
accurately from its absorbance characteristics. A solution containing exactly 1mg/ml 
will have an absorbance of 0.1486 AU in a 10mm pathlength cuvette. Using 
proportionality, one can then calculate the CD value for a CSA solution once its 
absorbance at 285nm as been accurately determined. 
 

Name (1S)-(+)-10-camphorsulphonic acid 
Source Sigma C-1395 
MW 232.3 
Target conc. 1mg/ml 
Solvent Distilled water 

 
Firstly, make up a solution of CSA at about 1mg/ml in distilled water. Determine its 
concentration accurately by measuring its absorbance maximum at 285nm in a 10mm 
pathlength cell. It is important to use the Absorbance program (see section 3.1.3) to 
calculate the absorbance of the sample rather than rely on the absorbance derived during 
the CD measurement. That is because the absorbance derived during a CD measurement 
is an approximation (see Appendix A of the Technical Overview section of the manual 
for its derivation). 
 
The concentration is calculated thus: 
 

Concentration of CSA (mg/ml) = (Observed absorbance/0.1486) 
 
and the expected CD value for this concentration in a 10mm pathlength cell at 290.5nm 
thus: 
 

CD value at 290.5nm = 335 x (Observed absorbance/0.1486) 
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Use the Monochromator panel to set the wavelength to 290.5nm and the bandwidth to 
1nm; use the Sampling panel to set the Time per point to 1 second. If you have 
administrator privileges, the Calibration… button in the CD signal Baseline panel will 
be active. Click on it to reveal the CD calibration dialogue and make a note of the 
current Desired CD value (mdeg) and Calibration value.  Then, should you get into 
trouble with the procedure described below, you can re-instate the old values and 
activate them by clicking on Apply and then OK.  
 

 
 
Type the CD value you have just calculated for your CSA solution into the Desired CD 
value (mdeg) edit box and click on Measure. The calibration procedure will take a 
measurement of the CD at 290.5nm and adjust the Calibration value automatically. If 
you are happy with the outcome, click on Apply and OK. 
 
Check that the calibration is correct by measuring the CD spectrum of your CSA in the 
range 320nm<O<260nm and use the cursor in Pro-Data Viewer to establish that the 
observed and calculated values at 290.5nm are the same. 
 
Recalibrating the derived absorbance 
 
The derived absorbance calculated during a CD measurement is an approximation. It 
will be fairly accurate if the calibration value is correct. In the file c:\program 
files\Applied Photophysics\chirascan\config\autoabs.conf you will find a single number. 
It is the scaling factor that relates the true absorbance to the derived absorbance. To 
adjust this scaling factor, you must measure the true absorbance of a sample and then its 
derived absorbance in CD mode. Accurate knowledge of the concentration of the 
sample is not required. Calculate the correction factor thus: 
 

Factor = True absorbance/Derived absorbance 
 
and multiply the scaling factor in the autoabs.conf file by the correction factor. 
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Method  
 
A sample whose absorbance is approximately 0.5AU is used in the factory and gives 
good results. We use an absorbance calibration standard from Starna, known as 
‘didymium’ but any absorbing sample will do.  3 mg/ml of CSA in a 10mm cuvette 
should give an absorbance of approximately 0.45AU relative to water at its absorption 
maximum of 285nm. (It is not essential to use CSA and you may choose to use another 
compound – all that is important is that the sample have a significant absorbance at a 
convenient wavelength.) 
 
Ensure the instrument has warmed up. For CSA, set the monochromator to measure in 
the range 270nm<O<300nm at 0.5nm step and 1nm bandwidth. Set the time per point to 
1s. (For other compounds a different wavelength range would be used of course.) 
 
Place a blank (water) in the sample compartment. Select Circular Dichroism in the 
signal panel and click on Baseline.  Before removing the blank, select Absorbance from 
the drop down menu in the signal panel and click on Baseline again. Now replace the 
blank with the sample. Without changing anything, click on Acquire in the Sequencer 
panel to measure the true absorbance spectrum. Now select Circular Dichroism from 
the drop-down menu in the Signal panel. Click on Show… in the Baseline panel and 
Load the CD baseline measured previously. With the CD baseline loaded, click on 
Acquire in the Sequencer panel to measure the CD spectrum and derived absorbance of 
the sample. 
 
To see the derived absorbance spectrum, right-click on the y-axis legend and select 
Absorbance from the menu. Use the cursor to determine the absorbance maximum of 
both derived and true absorbance and from this, determine and apply the correction 
factor as described above. 
 
Things to know about the derived absorbance 
 
It is an approximation. Its function is to provide you with a fairly accurate indication of 
whether or not you are within reasonable absorbance limits when measuring a CD 
spectrum. 
 
The scaling factor will vary slightly with wavelength  - ensure the scaling factor is 
calculated using a wavelength reasonably close to where most of your measurements 
will be carried out. 
 
The scaling factor will change slightly as the detector ages. Occasional checking of the 
scaling factor is advisable. The frequency will depend upon usage of the instrument but 
once every six months or so would be appropriate for most laboratories. 
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Notes 
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4.0 Launching Pro-Data Viewer   
Pro-Data Viewer is a program whose primary purpose is to display and manipulate 
spectra and to store them securely. It can be launched as a stand-alone program using 
the desktop icon (above) and will open at the current working directory. 
 
It can also be launched from the spectrometer control panel (SCP) by clicking on the 
Pro-Data Viewer launch icon in the SCP toolbar, when a client-server link between the 
SCP and Pro-Data Viewer is established automatically. In this mode, Pro-Data Viewer 
becomes a live display for data as they are collected. It can still be used for display and 
manipulation purposes when it is on-line. 

 

 
Pro-Data Viewer opens with two windows, the launchpad and the display 

 
If Pro-Data Viewer is started independently of the SCP using the desktop icon and 
subsequently you wish to establish a link between the programs, it is achieved by 
selecting Preferences>Go on-line from the Viewer launchpad. Selecting the Local 
option in the dialogue box will establish the client-server link. The status of Pro-Data 
Viewer can be established by looking at the status bar at the foot of the launchpad 
window, where the words Ready (Online) or Ready (Offline) will be found. 
 
The client-server architecture permits remote monitoring of experiments in progress. If 
a copy of Pro-Data Viewer is installed on a remote computer, establishing a client-
server link (Preferences>Go on-line>Remote) with the Chirascan will enable you to 
follow an experiment from another location. The IP address of the Chirascan computer 
will not be the same as the default local IP address – your network administrator will be 
able to advise you. 
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4.1 File structure – the Datastore 
Data are written to a file called a Datastore, which is a proprietary format designed for 
handling multi-dimension data. Its content will depend upon the type of experiment that 
is carried out. Some knowledge of the structure of Datastores will be helpful in 
understanding some of the functionality of Pro-Data Viewer. 
 
For single CD spectra, a one-dimension Datastore is generated and would contain for 
each wavelength (the dimension) the following data (properties): CD, detector HT, 
absorbance, temperature, the detector signal voltage (DC component) and the number of 
samples taken.  
 
A two-dimension Datastore would contain these properties (CD, HT etc) as a function 
of  wavelength and temperature, for example. A three-dimension Datastore might 
contain properties as a function of wavelength, temperature and cuvette position (for an 
experiment using the 4-positon cell changer). All data from a given experiment are 
written to a single Datastore. Subsequently, the Datastore can be mined for subsets of 
the data. 
 
Experimental parameters (wavelength range, step-size, time per point, bandwidth) plus 
sample information provided by the user via the Setup… dialogue box in the 
spectrometer control panel (sample description, concentration, cell type and pathlength) 
are stored as a header to the Datastore. 
 
NB The Datastore file format is designed for Pro-Data multi-dimension data acquisition 
and is not suitable for direct access outside the Pro-Data environment. A range of file 
export options is provided within Pro-Data, generating formats that are suitable for 
third-party applications. 
 
 



 

4.5 
Updated October 2006 

4.2 Displaying and selecting data 
One or more files can be displayed in the graphics window: 
 

x To display a single file, drag it from the launchpad onto the graphics window. 
Alternatively, double-click on the filename or right click and choose Open. 

x To add a file to the graphics window, drag it onto the display. 
x To display more than one file at a time, select multiple files from the list in the 

usual way (using the mouse pointer with Ctrl or Shift keys) and drag them onto 
the graphics window. 

x To add more than one file at a time, select multiple files from the list and drag 
them onto the display. 

x To reset the display, right-click in the display window and select Reset View. 
 

 
Six files selected in the launchpad and dragged onto the display 

4.2.1 Zooming and re-scaling the display using the 
mouse 
To zoom in to a particular part of the display, click and hold the left mouse button 
whilst moving the pointer to create a box around the area of interest. On releasing the 
left mouse button, the newly-created box will expand to fill the display window. To 
return to full display, simply double-click the left mouse button in the display area. 
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Drag pointer 
to create box 

 
Use the mouse wheel to expand or contract both axes simultaneously. Hold down the 
Ctrl key and use the mouse wheel to expand or contract the horizontal axis. Hold down 
the Shift key and use the mouse wheel to expand or contract the vertical axis. 
 

            
Wheel alone (zoom x,y)      Ctrl + wheel (zoom x) Shift + wheel (zoom y) 

 
The zoom functions can be used in any combination. To return to the default full-screen 
display, double-click at any time in the display area. 

4.2.2 Selecting a spectrum in the display 
A spectrum can be selected in a number of ways. Once selected, it changes colour to 
black, is highlighted with ‘selection marks’ and cross-hairs appear on it giving the value 
of the x- and y-coordinates at the position of the cross hairs. Single spectrum selection 
methods are listed below. 
 

x Place the mouse cursor close to the trace of interest. Click the left mouse 
button to select it. Click a second time to deselect it. 

 
x Click on the drop-down list beneath the toolbar to reveal a list of the spectra 

displayed. Click on a filename to select it. 
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x Right-click anywhere in the display window to reveal a pop-up menu. Choose 

Select Specific Traces to open a dialogue box containing a list of the spectra 
displayed. Click on a filename to select it and on OK to close the dialogue box. 

 
x From the menu bar, click on Trace>Selection Dialog to open the selection 

dialogue box. Click on a filename to select it and on OK to close the dialogue 
box. 

 

x From the toolbar, click on the icon  to open the selection dialogue box. 
Click on a filename to select it and on OK to close the dialogue box. 

 
x From the keyboard, use the shortcut D to open the selection dialogue box. 

Click on a filename to select it and on OK to close the dialogue box. 
 

 
CD spectrum of lysozyme with baseline selected. Note the file name, selection marks, 

cursor cross-hairs and the x,y coordinates just beneath the icon toolbar.  
 
The method of selection will depend upon personal preferences and upon the number of 
spectra or traces displayed. For example, if you wish to select one spectrum from 
several overlapping spectra, using the dialogue box or drop-down list is easier than 
using the mouse pointer. Once a spectrum is selected, the Up / Down cursor keys can be 
used to move the selection sequentially through the displayed spectra. 
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4.2.3 Selecting more than one spectrum 
Selecting more than one spectrum or trace is often required, for example to average a 
number of identical spectra. Variations in the methods described in the previous section 
to select a single spectrum are used to select more than one. 
 

x When using the mouse pointer to select spectra, hold down the Shift key and 
click on the spectra of interest. Clicking on the same spectrum twice with the 
Shift key depressed will first select it and then deselect it. 

 
x When selecting from the drop-down list, hold down the Shift key and click on 

the filenames of interest. Clicking on the same filename twice with the Shift 
key depressed will first select it and then deselect it. 

 
x When selecting from the Trace manipulation dialogue box, use the Ctrl and 

Shift keys in combination with the mouse to select filenames in the usual way. 
Selected files are highlighted. 

 
In general, using the dialogue box is the preferred method when dealing with more than 
one or two spectra. (See Section 4.3 et seq.) 
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4.3 Manipulating traces 
Operations such as baseline subtraction or averaging of traces will often be required. 
When any more than one or two traces are displayed, or if traces overlay each other, it is 
recommended that the Trace Manipulation dialogue box be used (keyboard shortcut D, 

icon ). 

4.3.1 The Trace Manipulation dialogue box 
The Trace Manipulation dialogue box is an environment in which data (traces) can be 
corrected, combined with other data or otherwise manipulated. All operations carried 
out within this environment are reversible, which means that if errors are made they can 
be quickly and easily corrected. The original data are never over-written or otherwise 
destroyed and all operations carried out on data are recorded in the History file. The 
results of the manipulations are displayed in real-time and can be saved at the end of the 
session using the File>Save current plot (Shift+S) in one of a number of formats. 
 

 
The Trace Manipulation dialogue box before data are displayed in the graphics window 
 
The structure of the dialogue box is straightforward. There are two windows, one of 
which lists any traces that are visible in the graphics window, the other listing those that 
have been removed from the display during the session and are no longer shown in the 
display. The buttons on the right execute actions on traces that have been highlighted in 
the Visible Traces window. Traces can be swapped between the Removed Traces and 
Visible Traces window using the arrow buttons between the two panes. Single arrow 
will move a selection, double arrow will move all listed traces. 
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4.3.2 Manipulating spectra within the dialogue box 
In the example below, there are six traces (3 repeat baselines and 3 repeat lysozyme 
spectra). We will average the baselines, average the spectra, subtract the average 
baseline from the average spectrum, smooth the resulting baseline-corrected lysozyme 
spectrum and remove the original data. The end result will show the lysozyme spectrum 
and its residual (calculated minus observed spectrum).  
 
With the data loaded into the display as previously described and the display window 

active, press D or click on  to call up the dialogue box. 
 

 
Raw data with dialogue box called up 

 
The first three files are baselines; the second set of three are the lysozyme spectra. 
 

x Select the first group of three files and click Average. 
 
x Select the second group of three files and click Average. 

 
The files average::0  (average of the baselines) and average::1 (average of the spectra) 
will be added to the Visible Traces list and are plotted in the display. 
 

x Select the file average::0 and click Set Baseline. 
 
x Select the file average::1 and click Subtract Baseline. 
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The file subtract::0 (baseline-subtracted spectrum) will be added to the Visible Traces 
list and is plotted in the display. 
 

x Select subtract::0 and click on Smooth. A new dialogue box will appear. 
 

                 
Example of an appropriate smooth (left, noise randomly distributed about zero) and an 

inappropriate one (right, structure in the residual caused by differences between 
calculated and observed spectra) 

 
In the Window Size box, type an integer whose value will depend on the step resolution 
used during the measurement and the sharpness of the features in the spectrum. The 
number should be as large as is possible without distorting the spectrum. Examination 
of the residual plot will show if any distortion has occurred. If the noise is randomly 
distributed about zero, the smoothing process has not caused any distortion and, 
importantly, you have the evidence to prove it. When you are satisfied with the 
smoothing process, click OK. 
 

x Click Unset Baseline. 
 

x Select Smooth (s):0 and Smooth (r):0 and click Remove Others. 
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x Click OK to close the dialogue box. The result of the above manipulation is 
shown below. 

 

 
Lysozyme – a smoothed, baseline-corrected spectrum with its residual. 

 
Note that even after closing the Trace Manipulation dialogue, any removed traces are 
remembered. Should you wish to carry out further manipulation, simply re-open the 
dialogue and all the traces will be listed, whether visible or removed, enabling you to 
carry on where you left off. 
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4.3.3 Saving data 
The manipulated data are not saved automatically. To save the result, go to File>Save 
Current Plot… (keyboard shortcut Shift+S) to call up the Save As… dialogue box or 
File>Save selected traces (Ctrl+Shift+S). The original raw data are never over-written. 
The results of any manipulation are stored in a new Datastore and a complete history of 
the manipulated traces is contained in the History of that Datastore, an example of 
which is shown below. 

 

4.4 Multi-dimension datasets 
A simple measurement of a property (e.g. fluorescence, absorbance, CD) as a function 
of wavelength is the most usual form of measurement carried out on a spectrometer. 
These are one-dimension measurements. Occasionally, more sophisticated 
measurements are needed, resulting in multi-dimension datasets. 
 
A stepped temperature-ramp, when a full spectrum is measured at each of a series of 
temperatures, is an example of a two-dimension dataset. When such a measurement is 
carried out using the Chirascan, the resultant Datastore contains properties measured as 
a function of both wavelength and temperature. Another example is a titration 
experiment, when a full spectrum is measured at each of a series of concentrations. The 
resultant Datastore contains properties as a function of wavelength and concentration of 
titrant. 
 
Higher dimensions can be added too. If a stepped temperature-ramp is carried out using 
the 4-cell auto-changer, then cell position becomes a third dimension and the Datastore 
contains properties as a function of temperature, wavelength and cell position. 
Substituting time for temperature would result in a Datastore containing properties as a 
function of wavelength, time and cell position. 
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4.4.1 Displaying multi-dimension datasets 
In the example that follows, an experiment was set up to measure a CD spectrum of 
lysozyme (190nm<O<260nm) for each of four cells mounted in a cell auto-changer at 
temperature intervals of 2.5oC from 10oC to 80oC. The three independent variables 
make it a three dimension dataset.  Load the file in the usual way from the Pro-Data 
Viewer launchpad to display a set of CD spectra, one for each temperature, for cell 
position 1. The Viewer display is subtly different when a Datastore of more than two 
dimensions is displayed - a slider-bar representing the third dimension (in this case cell 
position) is added beneath the toolbar. The spectra from each cell can be displayed by 
moving the slider to the appropriate position on the bar. 
 

 
Stepped temperature-ramp showing first cell CD spectra. Note the slider-bar 
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4.4.2 Changing the display axes 
Right-click on the x-axis legend Wavelength (nm) to display the dimension menu: 
 

 
 
Wavelength (in the X column) and Temperature (in the Z column) are highlighted, 
indicating that in the display above, wavelength is the x-axis and the CD spectra at 
different temperatures are projected down the z-axis onto the display. The third 
dimension is shown in the slider-bar. To change the display, select a different 
combination of x- and z-axes from the menu, for example Wavelength and Cell. 
Temperature will appear as the third dimension in the slider-bar: 
 

 
Stepped temperature-ramp showing CD spectra for each of the four cells at 10oC 
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Spectra for the four cells can be displayed at any one of the temperatures at which they 
were measured simply by selecting the temperature from the dimension bar above the 
display.  
 
A property can be displayed as a function of the dimensions in any combination but not 
all combinations yield particularly informative views of the data. One that does provide 
useful views is Temperature (in the X column) and Cell (in the Z column) with 
wavelength as the third dimension. This view shows how the chosen property changes 
with temperature at a single wavelength for each of the four cells. 
 
Once data are displayed, they can be manipulated as previously described in this 
manual.  
 
 

 
Stepped temperature-ramp showing CD profiles for each of the four cells at 198nm 
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4.4.3 Mining multi-dimension Datastores 
Higher-dimension Datastores can be mined for subsets of the original data and the 
subsets saved as new files. The process is recursive, so higher-dimension Datastores can 
be reduced to their simplest one-dimension forms if required.  Below is an example of 
how to mine a two-dimension Datastore. Right-click on a two-dimension Datastore in 
the launchpad file list and select Decompose Data from the menu. A Subset Dimension 
Ranges dialogue box will appear: 
 

 
 
The Subset Dimension Ranges dialogue box shows that the Datastore has two 
dimensions, wavelength and temperature, and the ranges those dimensions span. The 
Primary check-boxes are used in determining the lowest output dimension of the mined 
data subsets and which dimension it is. 
 
In the example below, the range of temperatures will be reduced and wavelength will be 
the primary dimension, i.e. when the Datastore is decomposed, new one-dimension 
Datastores each containing a CD spectrum will be created for every temperature 
measured  in the range 50oC<T<80oC. In the dialogue box, specify the temperature 
range and deselect the Temperature check box. 

 

 
 

Click on Save As to save the subsets. Refresh the launchpad directory tree and the new 
Datastores will be listed in a new folder created in the directory of the original Datastore 
(see below).  
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The original Datastore is highlighted in the directory tree and its directory (folder) is 
called Temperature Wavelength. The folder Cell3 is user-specified in the Save As 
dialogue box: it contains a two-dimension Datastore (Cell3.dsa) with CD spectra for 
every temperature in the specified range and an automatically created folder named 
Wavelength. In Wavelength, there are one-dimension Datastores for each temperature, 
each with a CD spectrum for that temperature. 
 
Three-dimension Datastores can be decomposed using the same rules. Please note that 
large numbers of Datastores can be created at the push of a button. An example of a 
directory tree created from a single three-dimension Datastore is given below - the 
original Datastore is highlighted. The decomposed data were restricted in temperature 
(50oC<T<80oC, 2.5oC interval) and to two cells (3 and 4) with wavelength 
(190nm<O<260nm, 1nm step-size) as the primary dimension. The restrictions use well 
under half of the original data and we still create fifty-two one-dimension, fifteen two-
dimension and one three-dimension Datastores. 
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The number of Primary dimensions checked will determine the lowest-dimension 
Datastore created. In both the above examples, only one Primary tick-box was checked 
and the decomposition therefore resulted in a series of one-dimension Datastores 
together with the higher-dimension Datastores created en route. If two boxes had been 
checked, the decomposition would have been halted at the two-dimension level; in the 
three-dimension case, had all Primary boxes been checked, a single three-dimension 
Datastore would have been created with the range restrictions specified in Range Min 
and Range Max fields. 
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Example of a directory tree created when a 3-D Datastore (Lyso_TWC) is decomposed 
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4.5 Displaying different properties 
Right-clicking on the y-axis legend will display a menu of the properties recorded 
during a measurement. To change the property displayed, select one from the list 
(double-click). 

 
Right-click on the y-axis legend for a list of properties available for display 

 
When run in CD mode, six properties are recorded with every measurement made on 
the Chirascan. These are: 
 

x Circular dichroism 
 
x HT (detector high voltage) 
 
x Absorbance (derived from the detector HT) 
 
x Temperature at which the measurement was taken 
 
x Voltage (a record of the actual detector DC voltage achieved) 
 
x Count (the number of 25Ps samples taken at every step in the scan) 
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Absorbance spectra for water (red) and lysozyme in water relative to N2

 
Traces in the new property can be selected and manipulated as previously described in 
this manual. 
 
N.B. If more than one Datastore has been dragged onto the default display, only the first 
one is displayed when the property is changed. Others must be dragged on to the new 
property window to display them. 
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4.6 Launchpad toolbar icons 

 
 
Positioning the cursor over the icon will call up a brief description of it; a fuller 
description is also provided in the status bar at the foot of the launchpad. 
 

  Define the selected directory as the working directory. 
 

x Click on this icon to define the currently selected directory (folder) as the 
working directory, i.e. the directory in which any new data files will be stored. 
The current working directory is always shown in the box immediately above 
the toolbar icons and in the above example it is C:\Documents and 
Settings\…\Chirascan data. The directory name will sometimes need to be 
contracted to fit in the box but the first and last part of the name are always 
shown. 

 

 Go to the current working directory. 
 

x Click on this icon to take you to the current working directory. 
 
 

  Move up one level. 
 

x Click on this icon to move back one node (directory). Use this if you wish to 
access files in another directory further up the tree. 

 

  Create a new folder in the currently selected directory. 
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x Select the directory (folder) in which you want to create a new folder and then 

click on this icon. The selected directory will open and a New Folder will be 
created. 

 

  Browse for other folders. 
 

x Clicking on this icon opens a browser window from which you can navigate 
quickly and easily to other folders. Selecting one and clicking on OK will set 
that directory to be the current working directory. 

 

  Refresh the current directory tree display. 
 

x Click on this icon to refresh the directory tree display. It is useful after saving a 
file, e.g. after averaging or smoothing, because the live directory is not 
automatically updated.   

 

  Activate context sensitive help. 
 

x Click this icon and then on item of interest to call up the context sensitive help. 
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4.7 Graphical display toolbar icons 

 
 
Positioning the cursor over the icon will call up a brief description of it; a fuller 
description is also provided in the status bar at the foot of the launchpad. 
 

 Save all the traces in the display into a new file. 
 

x Click on this icon to call up the Save As… dialogue box from where you can 
specify a filename and choose a location for the new file. 

 

 Print the active document. 
 

x The graphical display will be printed with associated information including 
filename, wavelength range, bandwidth and step size printed on a separate 
page. An audit trail (history) of the data can also be printed. 

 

 View and edit remarks. 
 

x Clicking on Remarks… will cause an edit box to appear enabling you to record 
information in addition to that recorded automatically or entered through the 
Setup… dialogue box in the SCP. 

 

  View history. 
 

x Click on this icon to call up a history of the operations performed on the trace. 
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 Set baseline 
 

x This icon sets a selected trace as a baseline. Click it again to reset the trace to 
its original status. 

 

 Add baseline to trace 
 

x Click on this icon to add a previously defined baseline to a selected trace or 
traces. It is useful if a baseline has been subtracted inadvertently from a trace. 
This icon is inactive if no baseline has been defined. 

 

 Subtract baseline from trace 
 

x Click on this icon to subtract a previously defined baseline from a selected 
trace. This icon is inactive if no baseline has been defined. 

 

 Fit the selected trace 
 

x A dialogue box appears enabling you to choose from a number of fitting 
schemes. Of use mainly for kinetic work. 

 

 Average the selected traces 
 

x The average of the selected traces is added to the plot. 
 

 Average all traces 
 

x Take the average of all traces in the display, plot it and remove the original 
data. 
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 Simple math (arithmetic) 
 

x Click on this icon to open a dialogue box that enables you to add, subtract, 
multiply or divide a trace to, from or by a constant. 

 

 Smooth the selected trace 
 

x A dialogue box appears enabling you to apply a reversible Savitsky-Golay 
smoothing operation. The smoothed trace and (optionally) its residual are 
plotted. 

 

 Convert CD units 
 

x A dialogue box will appear enabling you to convert from the current CD units 
to other ones. 

 

 Open Trace Manipulation dialogue box 
 

x Click on this icon to call up the Trace Manipulation dialogue box. 
 

 Open Thin Data dialogue box 
 
x If high density data is displayed (usually spectra-kinetic data), click on this 

icon to open a dialogue box to thin out the data.  
 

 Remove overlaid traces 
 

x Click on this icon to remove all overlaid traces from the display.  An overlaid 
trace is one whose property and dimension (e.g. CD and wavelength) are the 
same as those of traces already in the display but whose wavelength range or 
step-size or bandwidth differs from the originals. 
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 Change x-axis to logarithmic scale 
 

x Toggle between a logarithmic and linear x-axis. A logarithmic scale can be 
useful for kinetic studies where simultaneous visualization of fast and slow 
events is required. 

 Recompute trace colours 
 

x Click on this to reset the trace colours to the first available in the colour palette. 
This can be useful after trace manipulation if the automatically assigned 
colours are not suitable, e.g. too pale. 

4.8 Launchpad drop-down menus 
Much of the functionality of the launchpad is more readily accessible from the toolbar 
icons and mouse functions than from the drop-down menus. For completeness, 
however, a full list of the menu functions is given below.  

4.8.1 The File menu 

 
 
The File menu presents the usual options for dealing with files. 
 

x Open…  (Ctrl+O) will open a selected file in a new graphics display window 
 
x Delete deletes the selected file 
 
x Rename enables you to rename the selected file 
 
x Exit will close Pro-Data Viewer 
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With the exception of the Exit function, right-clicking on a filename gives access to all 
the File functions and more. 
 

x Browse with Explorer will open a window in the directory containing the 
selected file 

 
x Export data… allows you to export data in different formats. The default 

format is comma separated values (.csv) suitable for input to third-party 
programs such as Excel. Exported data are saved via a Save As… dialogue box. 

 
x Decompose data opens a dialogue box that allows you to create subsets of data 

contained in a multi-dimension Datastore and to save the subsets in new 
Datastores. See Section 4.3.3 for details. 
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4.8.2 The View menu 

 
 

x Close all viewer windows is a quick means of closing all Pro-Data Viewer 
graphical displays. It is useful if Single Window in the Preferences drop-down 
menu has not been selected. 

 
x Always on top is a toggle to force Pro-Data Viewer to be the top window.  

4.8.3 The Directory menu 

 
 

x Move up level will take you back through the directory tree one node at a time 
 
x Set working directory will define the currently selected directory (folder) as the 

working directory 
 
x Back to working directory will take you directly back to the current working 

directory 
 
x New folder will create a new folder in the currently selected directory 
 
x Browse for folders allows you to browse easily for a directory that can then be 

set as the working directory 
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 4.8.4 The Preferences menu 

 
 

x Single Window when selected means that every time a new graphical display is 
opened during data acquisition, the previous one is closed and thus only be the 
latest display is open. If it is not selected, then every time a new measurement 
is made, the previous displays are not closed; the new display overlays the old 
display, which itself can be revealed by dragging the top display window to 
one side. If you are running an experiment that involves a lot of repeat 
measurements, it is recommended that Single Window be selected; if not, you  
could end up with a large number of displays to close. If you find that you have 
many windows to close, go to View>Close all viewer windows. Note that 
Single Window has no effect when opening files from the launchpad. 

 
x Go on-line will display the Connect window and you will be asked to supply 

the Chirascan IP Address. It is used when Pro-Data Viewer has been started as 
a stand-alone program and you want subsequently to establish a link with the 
spectrometer control program (SCP). If the two programs are running on the 
same computer, select Local in the Connect window. The IP address under 
these circumstances is always the default 127.0.0.1.  

 

 
 
The client-server architecture permits remote monitoring of experiments in progress. If 
a copy of Pro-Data Viewer is installed on a remote computer, establishing a remote  
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client-server link (Preferences>Go on-line>Remote) will enable you to follow an 
experiment remotely. The IP address of the Chirascan computer will not be the same as 
the default local IP address – your network administrator will be able to inform you. 
 
If the address is correct and the instrument is running, the Pro-Data Viewer display 
panel will open. Pro-Data Viewer will ‘listen’ to Chirascan and report its status, 
behaving as a real-time display. If the address in incorrect, an error message will appear. 
 

 

4.8.5 The Help menu 

 
 

x Pro-Data Help… to bring up the on-line help file.  Once open, you can use the 
drop-down menus or the rectangular buttons to find a specific topic or browse 
through the document. 

 
x Help Topics… to bring up the Contents, Index and Search window for the on-

line help. 
 

x About Pro-Data Viewer… to display the program version number and 
copyright. 

 
The on-line help is more readily accessible by pressing the function key F1 at any time. 
Additionally, if you wish to know something about a specific command, use the mouse 
cursor to highlight it in the drop-down menu and then press F1 – the help is context-
sensitive and will take you directly to the relevant part of the manual. 
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Use the mouse to highlight the command of interest and then press F1 to reveal a 

description of its function in the context-sensitive help manual. 

4.9 Graphical display drop-down menus 

 
 
Much of the functionality for the graphical display is more readily accessible from the 
toolbar icons, mouse functions and keyboard shortcuts than from the drop-down menus. 
For completeness, however, a full list of the menu functions is given below.  

4.9.1 The File menu 

 
 

x Save current plot… (Shift+S) saves all the information that is displayed in the 
active window via a Save As… dialogue box. A number of output formats can 
be selected. 
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x Save selected traces (Ctrl+Shift+S) saves only those traces that have been 

selected in the active window via a Save As… dialogue box. A number of 
output formats can be selected. 

 
x Copy to Clipboard (Ctrl+C) will copy the currently active window to the 

clipboard, where it is available to be pasted into other applications, e.g. 
Microsoft Word.  This function is useful for preparing reports and publications.  

 
x Print… (Ctrl+P) calls up a dialogue box enabling you to choose a printer and 

to print the display.  
 

x Close will close both the graphic display and the launchpad of Pro-Data 
Viewer. 

4.9.2 The View menu 

 
 

x Aux Dimension Ctrl is a toggle to show or hide the third dimension slider bar. 
It is of use when dealing with multi-dimension Datastores (see Section 4.4 et 
seq.). 

 
x Legend is a toggle to hide or show the trace names that appear by default at the 

side of a plot. The function can be more easily executed using the keyboard 
shortcut L or by right-clicking anywhere in the plot border and clicking on the 
Hide legend or Show legend pop-up that appears. 

 
x Remarks… calls up an edit box in which you can add comments to supplement 

information that is recorded automatically or entered through the Setup… 
dialogue box in the SCP. 
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4.9.3 The Trace menu 

 
 

x Show Trace Name is a toggle to show / hide the name of a highlighted trace 
when the mouse pointer is placed near to it. 

 
x Selection Dialog (D) calls up the Trace Manipulation dialogue box. See 

Section 4.2.4 for more details. 
 

x Select All (Ctrl+Spacebar) selects every trace in the display. 
 

x Deselect All (Alt+Spacebar) deselects every trace in the display. 
 

x Remove Selected (Delete) removes from the display any currently selected 
trace. Removed traces can be recovered using the Trace Manipulation dialogue 
box (D). 

 
x Remove Others (Shift+Delete) removes from the display any trace that is not 

selected. Removed traces can be recovered using the Trace Manipulation 
dialogue box (D). 

 
x Toggle selected as baseline (B) sets / unsets a selected trace as a baseline. 

 
x Add baseline (+) and Subtract baseline (-) become active once a baseline has 

been set and respectively add a baseline to a selected trace or subtract a 
baseline from it. 
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x Remove overlaid traces (Shift+R) removes all overlaid traces. An overlaid 

trace is one whose property and dimension (e.g. CD and wavelength) are 
compatible with those of traces already in the display but whose wavelength 
range or step-size or bandwidth is incompatible with those traces already in the 
display. Overlaid traces cannot be manipulated and are always coloured black 
to differentiate them from active traces. 

 
x Recompute trace colours (F10) will assign new colours to the traces in the 

display. Useful if after manipulation the colours of the traces are not 
satisfactory. 

 
x Reset (Shift+Enter) will undo all operations carried out on the original data and 

restore the original display. 

4.9.4 The Math menu 

 
 
All mathematical functions can be called up using keyboard shortcuts or toolbar icons. 
 

x Fitting… (F) calls up the fitting window. The fitting function is more useful for 
kinetic data than it is for measurements of spectra. See Section 4.10.1 for more 
details. 

 
x Average (A) calculates and plots the average of the selected traces. 

 
x Average All Traces (Shift+A) calculates and plots the average of all the traces 

in the display. The original traces are removed. Removed traces can be 
recovered using the Trace Manipulation dialogue box (D). 

 
x Simple Math… (M) opens a dialogue box that enables you to add or subtract a 

constant to a trace or multiply or divide a trace by a constant. It can be useful 
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for offsetting one trace from another for display purposes or for normalizing 
spectra for easier comparison. 

 
x Smooth… (S) opens a window for applying a smoothing algorithm to raw data. 

It allows you to optimize the smoothing before accepting it. See Section 4.10.2 
for more details. 

 
x Convert (Shift+C) opens a dialogue box that converts between CD units. See 

Section 4.10.3 for more details. 

4.9.5 The Scale menu 

 
 

x Set Plot Limits… (Shift+P) calls up a dialogue box that enables you to type in 
limits for the extent of the x- and y-axes. 

 
x Reset zoom (Shift+Ctrl+Z) rests the scales to the original display size. Double-

clicking anywhere in the display window will achieve the same thing. 
 

x X logarithmic (Shift+X) will change the x-axis to a logarithmic scale. This 
feature can be useful for kinetic data. 

4.9.6 The Window menu 

 
 
In the lower part of the drop-down menu, you can see the properties that are currently 
displayed in the graphics window and the one that is ticked is active. The default is a 
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single window displaying circular dichroism as a function of wavelength. However, 
several other properties are recorded and these can be displayed too. 
 

x NewWindow…  (Shift+W) calls up a list from which can be selected the 
desired property. The new window will be displayed at the same time as the 
original window in a tile format. 

 
x Close (Ctrl+Shift+W) will close the current active window. 

 
x Cascade will display in a cascade format all property windows (e.g. CD, 

absorbance, HT) that have been opened and are not currently minimized. 
 

x Tile will display in a tiled format all property windows (e.g. CD, absorbance, 
HT) that have been opened and are not currently minimized. 

 
x Arrange icons will tidy up any minimized property displays that have been 

strewn around the display window. 
 

x Windows… opens a dialogue box that enables you to activate or close displays 
selected from a list. 

4.9.7 The Help menu 

 
 

x Pro-Data Help… brings up the on-line help file). Once open, you can use the 
drop-down menus or the rectangular buttons to find a specific topic or browse 
through the document. 

 
x Help Topics… brings up the Contents, Index and Search window for the on-

line help. 
 

x About Pro-Data Viewer… to display the program version number and 
copyright. 
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The on-line help is more readily accessible by pressing F1 at any time. Additionally, if 
you wish to know something about a specific command, use the mouse pointer to 
highlight it in the drop-down menu and then press F1 – the help is context-sensitive and 
will take you directly to the relevant part of the manual. 

 

 
Use the mouse to highlight the command of interest and then press F1 to reveal a 

description of its function in the context-sensitive help manual. 
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4.10 Fitting, smoothing and converting 
Most of the Math functions are self-explanatory but the dialogue boxes for fitting, 
smoothing and converting data require further explanation. 

4.10.1 The Fitting dialogue box 
Select the curve you want to fit and open the Curve Fitting dialogue using Math>Fitting 

(F or ).  
 

 
Fluorescence quenching of N-acetyltryptophanamide with N-bromosuccinimide  

 
Data are fitted to a selected function using a Marquardt-Levenberg algorithm. The 
fitting dialogue presents a number of fitting equations and provides the appropriate edit 
boxes for the input of estimates of the fitting parameters. If you are unsure about initial 
starting parameters for the fit, click on the Estimate button to automatically generate a 
set of initial parameters. The initial parameters might not be very accurate. The curve 
associated with these parameters is plotted in the Preview window. 
 
The range over which the fit occurs (the extent of the x-axis, usually time) can be 
defined in the Fit Range fields. 
 
To initiate the fitting of the parameters to the data, click on the Fit button. The 
algorithm will iterate until convergence or the maximum number of cycles is reached. If  
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the fitting is successful, the parameters will be updated and the calculated curve plotted 
in the preview window. The associated residual trace (the difference between the 
observed and calculated data) will be displayed in the Residuals part of the preview 
window. The errors associated with the calculated parameters are displayed next to the 
calculated parameters. You will be able to judge the quality of the fit by inspecting the 
residual trace and the parameter errors. If the errors are large compared with the 
parameters, then it is likely that you have specified a fitting function which is more 
complicated than is justified by the data, i.e. the result is under-determined. The number 
of variable parameters can be reduced by locking a parameter using the tick boxes 
adjacent to the parameters but such locking must be justified and should be applied with 
care. 
 
If the fitting process does not converge within the selected maximum number of 
iterations, a warning is given. You may wish to increase the number of iterations up to a 
maximum of 1000. Be aware that 1000 iterations of the fitting algorithm may take some 
time. In some instances, the fitting does not converge because of the absence of a 
unique solution. This too is symptomatic of an under-determined model. 
 
When you are satisfied that the fit is a good one and the calculated parameters are 
sensible, you can print out a report by clicking on the printer icon. The report displays 
the data, the calculated fit data with residuals and the associated fitting parameters. 
 
To plot the fitted curve in the Pro-Data Viewer display, click on OK.  If you do not wish 
the residuals to be included in the Graph Window, deselect the Include Residuals in 
Final Plot option. 
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4.10.2 The Smoothing dialogue box 
Select the traces you want to smooth and open the Smoothing dialogue box using 

Math>Smoothing (S or ).  
 

 
 
A Savitsky-Golay smoothing algorithm is applied where a user-defined number of 
points is used to derive a smoothed point. The number of points can be changed in the 
Window Size dialogue box and the larger the number, the greater the extent of the 
smoothing. The optimum Window Size for a given dataset will depend upon two things 
– the step-size chosen for the measurement and the sharpness of the narrowest feature in 
the spectrum. The smaller the step-size, the larger the window can be for a given 
feature; the sharper the feature, the smaller the window must be for a given step-size. 
 
As soon as an integer number is entered in the Window Size edit box, the smoothed trace 
is calculated and overlaid on the raw data in the preview window. The residual trace is 
plotted in the lower pane. If no distortion of the trace has occurred, the residual will 
show only noise randomly distributed about zero. If the window becomes too large, 
structure will be seen in the residual. 
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On the left, a window of 5 has been used and the residual is only noise randomly 
distributed about zero. On the right, a window of 15 has been used and the residual 
quite clearly shows structure. For this example, a window of 15 is inappropriate and 
should not be used. 
 
In fact, for a typical protein whose spectrum was measured with a 0.5nm step-size, a 
window in the range 5 to 8 will be appropriate but inspection of the residuals is always 
absolutely essential to ensure that no artefact has been introduced by the process of 
smoothing.  
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4.10.3 The Convert dialogue box. 
Select the traces whose units you wish to convert and open the Convert CD units 

dialogue box using Math>Convert (Shift+C or ). 
 

 
 
The CD units of the selected trace are shown in the Convert From box; the units you 
wish to Convert To are chosen from the drop-down menu. 
 
When converting between millidegrees (mdeg) and delta A, a scaling factor is used and 
the conversion requires no further input. When converting from mdeg or delta A to units 
that are normalized in some way, further input is required. 
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To convert to molar delta A or molar ellipticity the calculation normalizes for (and 
therefore requires knowledge of) the molarity of the solution and the pathlength of the 
cell (cm). 
 
For proteins, it is usual to normalize for the number of amino acid residues as well as 
concentration and pathlength. When Mean residue molar delta A or Mean residue molar 
ellipticity are selected, the input required is the concentration of the protein (mg/ml), the 
pathlength of the cell used (cm) and the mean residue molecular weight. The default 
input for the Residue MW is 113, a commonly accepted value for the mean molecular 
weight of an amino acid residue. This default value can be changed if required. The 
units are presented in this way to make it possible for proteins that are not yet fully 
characterized to be normalized for comparative purposes.  
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Notes 

 
 
 
 
 
 
 
 
 
 
 



 
 
Keyboard shortcuts for Pro-Data display 
 

Short-cut Menu equivalent Function 
Alt+Shift+S (No menu equivalent) Calls up dialogue to select subset of data and save in a new file 
Shift+S File>Save current plot… Save all data in the display in a new file 
Ctrl+Shift+S File>Save selected traces Save all selected traces in a new file 
Ctrl+C File>copy to clipboard Copy current plot to clipboard 
Ctrl+P File>Print… Calls up print dialogue  

                                                                                                                                                                                                                                                                                                                                                    ------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------- 

L View>Legend Hide/show toggle for legend to left of plot 
                                                                                                                                                                                                                                                                                                                                                    ------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------- 

D Trace>Selection dialog Calls up interactive trace selection and manipulation dialogue  
Ctrl+spacebar Trace>Select all Selects all traces in the current display 
Alt+spacebar Trace>Deselect all Deselects all traces previously selected in the display 
Delete Trace>Remove selected Remove selected traces from the display 
Shift+Delete Trace>Remove others Remove non-selected traces from the display 
B Trace>Toggle selected as baseline Set/unset toggle to identify selected trace as baseline  
+ Trace>Add baseline Add a previously set baseline to any selected trace 
- Trace>Subtract baseline Subtract a previously set baseline from any selected trace 
Shift+R Trace>Remove overlaid traces Removes all traces whose dimensions differ from those of the originally displayed trace 
F10 Trace>Recompute trace colours Assigns new colours to the traces in the display 
Shift+Enter Trace>Reset Reset graphics window to initial state 

                                                                                                                                                                                                                                                                                                                                                    ------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------- 

F Math>Fitting… Calls up dialogue to allow mathematical fitting of a selected trace 
A Math>Average… Plots average of selected traces 
Shift+A Math>Average all traces Plots average of all displayed traces and removes original traces 
M Math>Simple math… Calls up dialogue for arithmetical operations on selected traces 
S Math>Smooth… Calls up dialogue for reversible digital smoothing of selected traces 
Shift+C Math>Convert Calls up dialogue to convert CD units for selected traces 

                                                                                                                                                                                                                                                                                                                                                    ------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------- 

Shift+P Scale>Set plot limits Calls up dialogue to set limits in x- and y-axes 
Shift+Ctrl+Z Scale>Reset zoom Scales display so that max and min x- and y-axis values define plot limits 
Shift+X Scale>X logarithmic Set x-axis to log scale (useful for time bases) 
Shift+O Scale>Online Autoscale Automatically rescales the display y-axis during data acquisition to show full spectrum 

                                                                                                                                                                                                                                                                                                                                                    ------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------- 

Shift+W Window>New window… Calls up a dialogue to select a new property to display 
Ctrl+Shift+W or Ctrl+F4 Window>Close Closes the active display (useful when more than one property displayed) 

                                                                                                                                                                                                                                                                                                                                                    ------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------- 

F1 Help>Pro-Data help… Opens the on-line help for the graphics window 
Alt or F10 (No menu equivalent) Toggles letter shortcuts for keyboard operation of menu functions 
Alt+F4 (No menu equivalent) Closes the active window 

                                                                                                                                                                                                                                                                                                                                                    ------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------- 

Spacebar (No menu equivalent) Toggles the cursor cross hairs on and off when a trace is selected 
Up/down cursor arrows (No menu equivalent) Steps selection sequentially through displayed traces 
Left/right cursor arrows (No menu equivalent) Steps cursor in x-axis when a trace is selected 



 
 
Mouse functions for Pro-Data display 
 

Short-cut Menu equivalent Function 
Point to trace and left-click Trace>Selection Dialog Trace name appears and left-click selects / deselects the trace 
Point to trace and Shift+left-click Trace>Selection Dialog As Point left-click but allows more than one trace to be selected  

                                                                                                                                                                                                                                                                                                                                                    ------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------- 

Double-left-click in display Scale>Reset zoom Automatically resets y-axis scale whilst maintaining x-axis plot limits set in Scale>Set plot limits 
Shift+double-left-click in display (No menu equivalent) Automatically scales both x- and y-axes to encompass limits of all displayed data 
Left-click and drag (No menu equivalent) Zoom in on the selected area of the plot 

                                                                                                                                                                                                                                                                                                                                                    ------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------- 

Right-click in display (No menu equivalent) Causes context sensitive menu to appear 
                                                                                                                                                                                                                                                                                                                                                    ------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------- 

Ctrl+mouse wheel (No menu equivalent) Zoom x-axis 
Shift+mouse wheel (No menu equivalent) Zoom y-axis 
Mouse wheel (No menu equivalent) Zoom x- and y-axes simultaneously 

 
 
 



 
 
 
Launchpad toolbar icons 
 
 

Icon Menu equivalent Function 

 
Directory>Set working directory Defines the selected directory as the working directory 

 
Directory>Back to working directory Go to the current working directory 

 
Directory>Move up level Move up one level 

 
Directory>New folder Create a new folder in the currently selected directory 

 
Directory>Browse Browse for other folders 

 
(No menu equivalent) Refresh the current directory tree display 

 
Help>Pro-Data help Activate context sensitive help 

 
 



 
 
 
Display toolbar icons 
 
 

Icon Menu equivalent Function 

 
File>Save current plot… Save all data in the display in a new file 

 
File>Print… Calls up print dialogue 

 
View>Remarks Calls up the remarks dialogue 

 
View>History View the history of the manipulations performed on the trace  

 
Trace>Toggle selected as baseline Set/unset toggle to identify selected trace as baseline  

 
Trace>Add baseline Add a previously set baseline to any selected trace 

 
Trace>Subtract baseline Subtract a previously set baseline from any selected trace 

 
Math>Fitting… Calls up dialogue to allow mathematical fitting of a selected trace 

 
Math>Average… Plots average of selected traces 

 
Math>Average all traces Plots average of all displayed traces and removes original traces 

 
Math>Simple math… Calls up dialogue for arithmetical operations on selected traces 

 
Math>Smooth… Calls up dialogue for reversible digital smoothing of selected traces 

 
Math>Convert Calls up dialogue to convert CD units for selected traces 

 
Trace>Selection dialog Calls up interactive trace selection and manipulation dialogue  

 
(No menu equivalent) Calls up data thinning dialogue 

 
Trace>Remove overlaid traces Removes all traces whose dimensions differ from those of the original 

 
Scale>X logarithmic Set x-axis to log scale (useful for time bases) 

 
Trace>Recompute trace colours Assigns new colours to the traces in the display 

 



 
Major changes in Pro-Data Chirascan spectrometer control panel (SCP) 
 

 
 
In the Baseline panel, Show… is used to reinstate a previously-measured CD baseline. 
It calls up a dialogue / preview box that enables you to load any baseline file. Refer to 
the Pro-Data manual section 3.1.1 for full details of its use. 
 
Also in the Baseline panel, Calibration… is used to recalibrate the instrument. You 
need system administrator privileges to do this and should refer to section 3.13 of the 
Pro-Data manual. 
 
The Sequencer panel has been simplified for use in Spectrum mode. You can specify 
a number of repeats and set time intervals to separate the measurements. The interval 
is between spectrum starts so that if you were to specify a 10 minute interval, there 
would be 10 minutes between the commencement of one measurement and the 
commencement of the next. The time taken to measure the spectrum, which is 
estimated for you in the Sampling panel once the measurement parameters have been 
defined, should be taken into account when deciding on a timed interval. All spectra 
measured during a Repeat measurement are stored in a single Datastore. 
 
The Sequencer panel can now operate in Kinetic and Spectra-Kinetic modes. Kinetic 
mode sets up the SCP for single-wavelength kinetic studies and Spectra-Kinetic mode 
sets it up for multi-wavelength kinetic studies. These modes would normally require a 
stopped-flow accessory, which will become available for Chirascan soon. 
 



 
Major changes in Pro-Data Viewer display and manipulation program 
 
Pro-Data Viewer has been thoroughly overhauled and it is recommended that the new 
manual be read in its entirety to fully appreciate the improvements. Reference is made 
to the relevant sections in the manual in the overview below. 
 
Keyboard short-cuts and toolbar icons are now available for virtually all functions and 
familiarity with them will save many mouse-clicks. Quick-reference sheets for 
keyboard shortcuts, icon and mouse functionality are supplied with the documentation 
and on the CD-ROM (Explore>Chirascan>Shortcuts). 
 

- Displaying previously collected data. The usual combinations of mouse clicks 
with Ctrl and Shift keys allow single and multiple file drag-and-drop onto the 
graphic display. See section 4.2. 

 
- Zoom functions: 

            
Wheel alone (zoom x,y)      Ctrl + wheel (zoom x) Shift + wheel (zoom y) 

 
The zoom functions can be used in any combination. To return to the default 
full-screen display, double-click in the display area. See section 4.2.1. 
 

- Selecting spectra in the display. In addition to point-and-click selection, 
spectra can be selected from the Trace Manipulation dialogue box, most 
conveniently accessed using the keyboard shortcut D. It simplifies the 
selection and subsequent manipulation of traces in the display and a sound 
grasp of its functionality will reward you with a much improved experience of 
this program. See sections 4.2.2 and 4.2.3 for selection options and 4.3 et seq 
for manipulation. 

 
- Exporting data. Right-click on a filename in the launchpad and select Export 

to export the data in CSV format for third-party applications (section 4.8.1). If 
many files are to be converted, it is better to use the APLdataconverter 
program supplied on the CD-ROM as multiple file selections can be 
simultaneously converted. 

 
- Multi-dimension datasets are generated when measuring CD as a function of 

(for example) wavelength and temperature. Displaying such data becomes 
difficult when a third dimension is introduced, for example cell position in a 
multi-cell turret. A display to accommodate three dimensions is incorporated 
in the new Viewer and is described in sections 4.4.1 and 4.4.2. 

 
- Mining multi-dimension datasets. Generating subsets of a multi-dimension 

dataset is a simple operation that is accomplished using the Decompose data 



 
dialogue. It enables you to restrict dimension ranges as well as output lower-
dimension subsets of the parent data. See section 4.4.3. 

 
- Fitting, smoothing and converting data. Most of the Math functions are self 

explanatory but these three require further explanation. See sections 4.10.1, 
4.10.2 and 4.10.3 respectively. 
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